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1 はじめに (Introduction) 

1.1 概要 (General Overview) 

Ocean Data View (ODV)は、海洋学あるいは他のジオリファレンスを与えられたプロファイル、連続または

グリッドデータを対話的に調べて可視化するコンピュータープログラムです。ODV のマルチプラットフォー

ム版は、Windows(9x/NT/2000/XP)、Linux、UNIX および Mac OS X の各オペレーションシステム上で動

作します。 

ODV のデータファイルおよび設定ファイルは、プラットフォーム(訳注: コンピュータの種類)に依存しませ

ん。すなわち、どのシステム上でそれらを作成しても、変換することなく他のプラットフォーム間で交換する

ことができます。ODV は大量の測点データを対話的に閲覧できます。また、高品質な測点図

(station-maps)、複数の成分間の一般的な成分間分布図(property-property plots)、選択した測点群の散

布図(scatter plots)、任意の航跡に沿った成分断面図(property sections)、一般的な成分の等値面図

(general iso-surfaces)を作成できます。ODV はオリジナルのスカラーおよびベクトルデータをカラードット、

数値または矢印で表示します。さらに、二種類の高速なグリッド・アルゴリズム(gridding algorithms)が、断

面や等値面のグリッド領域をカラー濃淡や等値線で描きます。多くの導数量(derived quantities)をオンライ

ンで計算します。これらの変数は、ディスクに保存される基本変数と同様に表示・解析されます。 

1.2 使いやすさ (Ease of Use) 

ODV は柔軟性に富み、使いやすいように設計されています。ユーザーは内部のデータ記憶フォーマット

の詳細を知る必要はなく、プログラミングの経験も不要です。ODV は利用可能な測点図を画面上に常に

表示し、ユーザーがマウスで測点(stations)、断面(sections)、等値面(iso-surfaces)を選択して簡単にデー

タを操作できます。画面上のレイアウトやその他の様々な設定は簡単に修正でき、気に入った設定は後

で使用できるように設定ファイルに保存できます。ODV は膨大なデータコレクションを比較的安価で広く

使われているモバイル・コンピュータ上で構築管理できます。新しいデータを受け取った時にデータコレク

ションを拡張するのも簡単です。現場観測中あるいは研究室に戻った後での科学的なデータ解析に

ODV は有用です。さらに、ODV はデータの品質評価が簡単なので、教育や研修にも役立ちます。 

1.3 高密度データフォーマット (Dense Data Format) 

ODV のデータフォーマットは、可変長で不規則間隔なプロファイルや、連続または測点データ向けに最

適化されています。膨大なデータコレクションでも高密度に保存でき、どの測点にも瞬時にアクセスできま

す。データフォーマットは融通がきいて、最大 50 個までの変数を個々のデータコレクションに保存できま

す。あるコレクションから別のコレクションへ変数の型と数を変えられます。ODV は個々のデータ値につい

て品質フラグを保持していて、これらの品質フラグは、解析時に不良または疑わしい値を除くためのデー

タ品質フィルター(data quality filter)として利用できます。 
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1.4 拡張性 (Extensibility) 

ODV は既存のコレクションに新規データを簡単に読み込むことができ、また、コレクションから一部または

全てのデータを出力することもできます。以下に示すフォーマットの海洋学データは広く用いられていて、

直接 ODV システムに組み入れることができます: 

 WOCE WHP data (Scripps の WHPO からインターネット経由で配布),  
 World Ocean Database (WOD98; WOD01; NODC から CD-ROM で配布),  
 World Ocean Atlas 1994 (WOA94; NODC から CD-ROM で配布),  
 NODC SD2 data  
 Java Ocean Atlas spreadsheet format, 
 ODV spreadsheet format. 

1.5 導変数 (Derived Variables) 

データファイルに保存される基本的な実測変数に加え、ODV は多くの導変数(derived variables)を計算し

て表示することができます。これらの導変数(ポテンシャル温度、ポテンシャル密度、力学高度(いずれも基

準層は任意)、中立密度、Brunt-Väisälä Frequency(ブラント─バイサラ周波数)、音速、飽和酸素など)は
ODV ソフトウェアにコード化されているか、あるいはユーザーによるマクロファイル(macro files)またはその

場(on-the-fly)で数式が定義できます。マクロ言語は簡単で、多くのアプリケーションで一般的に用いられ

ています。新しい導数量(derived quantities)に関する数式やマクロファイルを使うことで、ODV の適用範囲

が一層広がり、科学分野で未だ確立されていない新しい数量に関する実験が容易です。ODV にはマク

ロ・エディタが組み込まれているので、ODV マクロの作成と修正は簡単です。 

どの基本変数や導変数でも ODV プロットで表示でき、全て等値面（例えば等深面、等密度面、等温面ま

たはは等塩分面; 各成分の極大または極小層、例えば中層水の塩分極小層はこれらの変数(の導数量)
の鉛直微分が 0 の等値面として定義されます）の定義に使えます。 

1.6 プロットの種類 (Plot Types) 

ODV はカラーの成分断面(property sections)や三次元の等値面(iso-surfaces)上のカラー分布を、次のい

ずれかの方法で表示します; 方法 1: (ユーザーが定義したサイズのカラードットまたは数値で)データ取得

位置にオリジナルデータを表示します。方法 2: (可変分解能の)矩形グリッド上にオリジナルデータを投影

してからグリッド・フィールド(gridded fields)を表示します。方法 1 がデータの「ありのまま」の分布を瞬時に

作り出し、サンプリングの乏しい領域を顕にして、不良データ値を目立たせるのに対し、方法 2 は見た目

が良く、大きなドットサイズを使って上書きすれば方法 1 で起こる状態を回避できます。しなしながら、グリ

ッド・フィールドは作られたデータであって、グリッド化処理によって(オリジナル)データに含まれるいくつか

の小規模スケールの特徴を消してしまうことに注意してください。いずれの表示モードも、断面や表面の

データを専用のグリッド化，濃淡化および等値線描画ソフトウェアなどで使うためにアスキーファイルかクリ

ップボードに出力できます(export of section or surface data)。 
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全画面測点図 (Station Map) (拡大) 選択測点の成分間プロット (Property-property plots)
(拡大) 

 
測線に沿った成分断面図  (Property distributions 
along sections) 
(拡大) 

等値面上の成分分布図 (Property distributions on 
iso-surfaces) 
(拡大) 

全測点散布図 (Scatter plots of all stations) (拡大) ベクトル図 (Arrow Plot)  
 

1.7 グラフィクス出力 (Graphics Output) 

ODV グラフィクス画面(または個々のデータプロット; ただし PostScript, PNG または JPG のみ)のカラーまた

は白黒ハードコピーは、印刷(Print)コマンド経由か、PostScript ファイル(.eps)を作成することで容易に得ら

れます。eps ファイルは、どの PostScript プリンターでも印刷できて、ページ記述ドキュメントに含めることも

できます。また、表示画面の内容を、テキストドキュメントへの包含または標準的なグラフィックスソフト(GIF
と等価の PNG を使用)での後処理に適した PNG および JPG ファイルに書き出すことができます。ODV の

PNG および JPG の分解能は画面の解像度に依存せずに、ユーザーが設定できます。 
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1.8 NetCDF対応 (NetCDF Support) 

ODVには、地球科学の異なる分野の研究者に広く使われている netCDFファイルの対応機能が組み込ま

れています。ユーザーのわずかな指定や選択で、ODV は本来の ODV コレクションをエミュレートする方

法で、netCDF ファイルにアクセスして解釈します。NetCDF ファイルのデータを調べるために、ODV が持

つ全ての解析・可視化機能が使えるので、最初にデータを変換したり書き直したりする必要はありません。

NetCDF の構造と内容に応じて、別の ODV「エミュレーション」が可能です。個々のエミュレーションの設

定は、後の使えるようにディスクへ保存できます。NetCDF ファイルはプラットフォーム(訳注: コンピュータ

の種類)に依存しないので、ODV がサポートする全てのプラットフォーム上で同じファイルが使えます。 

1.9 ODVのモード  (ODV Modes) 

ODV は五つの異なるモード、MAP(地図)、STATION(測点)、SCATTER(散布図)、SECTION(断面図)、
SURFACE(表面)で操作できます。これらのモードは F8 から F12 キー(訳注: キーボードの上側にあるファ

ンクションキー)を押すか、背景ポップアップメニュー(background popup menu)から適切なオプションを選

ぶことで、いつでも簡単に切り替えられます。現在のモードと有効な設定ファイルは、ODV ステータスバ

ーの右端に常に表示されます。初期設定は STATION モード(新規データコレクションの初期モード)で
す。 

MAP(地図)モードは全画面の測点図を描画するもので、データプロットはできません。このモードは高品

質な航跡図の作成に使ってください（地図ウィンドウ(map window)のサイズと位置を定義して、五つの地

図投影法から選択して、適切な海岸線および海底地形を定義し、測点番号と航海ラベルの付いた個々

の測点が示されて、プリントアウトまたは PNG や JPG、EPS Postscript ファイルを生成します）。 

STATION (測点)モードは(以降の全てのモードと同様に)、測点図と一つ以上(最大 20)のデータプロット・

ウィンドウを生成します。このモードは、選択した測点に関する(任意の基本または導変数の)X/Y プロット

の作成に使用して下さい。地図中の測点上でマウスの左ボタンをクリックするか、航海ラベルと測点ラベ

ルを指定して測点を選べます。 “p”を押すと(または測点をダブルクリックして選択・表示させると)その測

点データを X/Y プロットに追加でき、Ctrl-X を押す(訳注: Ctrl キーを押しながら x を押す)と、画面をクリア

してやり直しができます(この操作は全モードで共通です)。 

SCATTER (散布図)モードでは(以降の全てのモードと同様に)、データプロットが Z 変数(任意の基本およ

び導変数)をサポートしています。ある X/Y の位置における Z 変数の値は X/Y の位置の色を定義します。

Z 変数によるプロットには(SECTION モードおよび SURFACE モードと同様に)、(1)X/Y の位置にカラードッ

トまたは実際のデータ値を配置する方法(初期設定)と、(2)観測データを基に推定した連続的なグリッド・

フィールドとして表示する方法の、二つの方法があります。グリッド・フィールドは、カラー濃淡および／ま

たは等値線で描画されます。SECTION モードや SURFACE モードと異なり、SCATTER モードのデータプ

ロットには(Z 変数の有無に関係なく)地図に表示されている全測点の全データ点(ただし有効な測点のみ)
が含まれます。 

SECTION (断面)モードのデータプロットも Z 変数をサポートし、SCATTER モードの全てのプロットタイプを

利用できますが、プロットに使える測点セットは、通常、ある航海に沿った断面帯に制限されます。断面帯

は任意で定義でき、正しく測点を選べるようにその幅を調整できます。このモードは、断面に沿った成分

分布、断面内の全測点に関する成分間プロット、および断面を横切る地衝流の計算・解析に使用してくだ

さい。 

SURFACE (表面)モードでは、三次元空間(経度／緯度／水深)の中で、ある変数(例えば深さ、密度、水

温など)が一定の値になる面を定義でき、その面上における他の変数の成分分布を表示できます。このモ

ードでは、ある面上における任意の成分間プロットも生成できます。 
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1.10 Ocean Data Viewのインストール (Installing Ocean Data View) 

CD-ROM または DVD 上の実行環境(WOCE V3 データリリースの DVD2 の eWOCE ディレクトリはそのよ

うな実行環境を含んでいます)から Ocean Data Viewを動作させることができます。もし ODVを定期的に使

用するのであれば、お使いになるコンピュータ上にソフトウェアをインストールしたほうがよいでしょう。

http://www.awi-bremerhaven.de/GEO/ODV/downloads-odvmp.html か ら Windows(9x/NT/2000/XP) 、

Linux、UNIX、Mac OS X 用の ODV インストールファイルがダウンロードできます。 

 

1.11 オプショナルパッケージのインストール (Installing Optional Packages) 

高解像度の海岸線と海底地形ファイル、または直ぐに利用可能な(ready-to-use)データコレクションのよう

な オ プ シ ョ ナ ル パ ッ ケ ー ジ は http://www.awi-bremerhaven.de/GEO/ODV/downloads-odvmp.html と

http://www.awi-bremerhaven.de/GEO/ODV/downloads-data.html からダウンロードできます。インストール

方法は readme ファイルを参照してください。 

1.12 ODVの起動 (Running Ocean Data View) 

一旦お使いになるコンピュータに ODV がインストールされれば、ODV を起動する方法はたくさんありま

す。 

Windows 上では、インストール後に ODV アイコンがデスクトップ上に置かれます。このアイコンをダブルク

リックするか、スタート>プログラム>Ocean Data View (mp)の順に選んで ODV を起動させることができます。

また、ODVのデスクトップアイコンをウインドウズのタスクバー上にドラッグすると、タスクバーの ODVアイコ

ンをシングルクリックして ODVを始められます。ODV がサポートしているファイルを(デスクトップまたはタス

クバーの)ODV アイコン上にドラッグすると ODV が起動してそのファイルが開きます。ODV が起動してい

る時は、ODV がサポートしているファイルを ODV のウィンドウにドラッグするとそのファイルが開きます。

ODV がサポートするファイルの種類には ODV コレクション(.var)または ODV スプレッドシート(.txt)が含ま

れます。 

Linux, UNIX または Mac OS X システム上では、それぞれのオペレーティングシステムで決められている

方法で ODV の実行ファイル odovmp の別名(エイリアス)またはデスクトップアイコンを作ることができます。

ODV の実行ファイルは ODV をインストールしたディレクトリ bin_…(ここで…の部分はシステムに依存しま

す; 例えば Mac OS X であれば macx、Linux システムであれば linux_i386 となります)の中にあります。タ

ーミナルウィンドウで実行ファイルの完全パスを入力して ODV を始めることもできます。いくつかのシステ

ム上では、スクリプトファイル run_odv を使ってコマンドラインから ODV を始めることができます。 

初めて ODV を実行すると、次の Quick Installation 情報が表示されて入力を促します: 

1. bin_…ディレクトリを含む完全パス名(環境変数 ODVMPHOME) 
2. ODV 実行中に一時ファイルを書き込むディレクトリの完全パス名(環境変数 ODVMTEMP)。この

ディレクトリには書き込み許可が必要です。システムの一時ディレクトリを使用するか、ローカルデ

ィスク上にこの目的のための特別なディレクトリ(例えば /odvmptemp)を作ることもできます。ネット

ワークドライブ上のディレクトリの使用は、ネットワークの転送速度が遅いのでお勧めできません。 
3. 使用するコンピュータ名 
4. ユーザー名またはログイン名 

OK を押すと Quick Installation が完了します。それから Configuration の General Settings ダイアログを使
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って ODV フォントと外部プログラムの設定を変更してください。ヘルプが必要なら、F1(または Help>Help 
Topics オプション)または多くのダイアログボックスにある Help ボタンを押してください。 

一旦 ODV を起動させれば、File>Open Collection または File>Open netCDF File オプションを使ってデ

ータコレクションや netCDF ファイルを開くことができます。何時 ODV がデータコレクションを開いても、最

後に ODV を使っていたときの設定が、最初にそのコレクションに対して適用されます。また、測点選択基

準も適用され、現在のデータコレクションにある測点の最初のサブセットだけが地図上に表示されます。

別の測点のサブセットまたは全測点を選ぶ必要があれば、Configuration>Selection Criteria を使ってくだ

さい。 

以前に保存した別の設定は Configuration>Load Configuration を使って呼び出せます。また、

Configuration>Use Template を使って定義済みの設定の雛形から一つを選べますし、Configuration メニ

ューまたは背景、地図、データプロットの一つの上でマウスの右ボタンをクリックしたときに現れるポップア

ップメニューを使って対話的に様々な設定を変更できます。Mac OS X 上でマウスの右ボタンをエミュレー

トするには Alt キーを押しながらマウスクリックしてください。 
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2 ODV画面レイアウト (ODV Screen Layout) 
 

 
 

ODV アプリケーション・ウィンドウは以下から構成されています(画面の上から下へ)： 

2.1 メインメニュー (Main Menu) 

 

メインメニューは以下の基本機能を提供します: 

File:コレクションのオープンまたは作成; netCDFファイルのオープン; バッチモードでの ODVコマンド

の実行; 現在の ODV グラフィクス画面の印刷; 現在の ODV グラフィクス画面を PostScript，
PNG または JPG ファイルとして出力; ODV の終了。 

Collection: コレクションのオープンまたは作成; netCDF ファイルのオープン、コピー、名前の変更、コ

レクションの削除; データコレクションの並び替えと圧縮; コレクションの変数変更、現在の測点

または選択されている測点のサブセットの削除。 

Configuration: 測点選択基準の変更; 導変数の定義; 等値面変数の定義; 地図およびデータプロット

のレイアウトの変更; 変数ラベルの変更; ODV テキストウィンドウの三行目(2.2 を参照)に表示さ

れる数値フォーマットと位置; 設定の読み込みと保存、または初期設定へ戻す。 

Import: 現在のコレクションへデータを読み込む(WOCE フォーマット, WOA94 CD, WOD CD, NODC 
SD2 フォーマット, ODV スプレッドシート・フォーマット, 二種類の ODV リストフォーマット)。 
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Export: 現在選択されている測点のデータ出力; アスキーファイルへのプロット値の出力。 

Utilities: データインベントリ・テーブルの作成と時系列データ分布図の作成; 検索ボックス内の平均; 
地衡流の計算と可視化; 現在のデータを基準として定義。 

Help: ODV ヘルプシステムの呼び出し; ODV web ページへの接続; バージョンの表示。 

2.2 三行テキストウィンドウ (3-Line Text Window) 

 

ここには現在の測点とサンプルの情報が表示されます。テキストウィンドウ上でマウスの右ボタンをクリック

するとデータの編集、変数ラベルの変更、二行目と三行目に表示される数値フォーマットとその並びを変

更できます。テキストウィンドウ上のある変数の上にマウスを動かすと、この変数のより詳細な情報がポップ

アップ・ウィンドウに表示されます。一行目の最初にある、括弧 [ と ] で区切られている範囲にマウスを動か

すと、現在の測点とサンプルの選択基準の概要がわかります。 

2.3 グラフィクス・キャンバス (Graphics Canvas) 

グラフィクス・キャンバスは ODV 測点図と一つ以上のデータプロットを含んでいます。地図だけ表示されて

いる時は、個々の測点(STATION モード)または地図上の任意の場所(その他のモード)をダブルクリック

するとデータプロットが表示されます。地図上でマウスの右ボタンをクリック(Mac では Alt キーを押しながら

マウスをクリック)すると、データプロットまたは背景領域に別のポップアップメニューを呼び出します: 

背景ポップアップメニュー (Background Popup Menu)： 

 

グラフィック・キャンバスをクリアして測点図に戻ります(測
点モードで描画のために選択されている測点のリストを

クリアするには二回操作してください); 現在の ODV グラ

フィクス・キャンバスの印刷; 現在の ODV グラフィクス・キ

ャンバスを PostScript, PNG または JPG ファイルで出力; 
導変数の定義; 等値面変数の定義; 地図とデータプロッ

トの配置の変更; ODV テキストウィンドウの三行目の変数

ラベル、数値フォーマットおよび位置の変更 ; MAP, 
STATION, SCATTER, SECTION および SURFACE モ

ードの切り替え; ODV の終了。 
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地図ポップアップメニュー (Map Popup Menu)： 

 

地図の拡大; コレクションの全領域の地図を開く(Define 
Full Domain で定義); 標準の全球地図の作成; 測点選

択基準の変更; 断面の定義(SECTION モードのみ); 名
称または内部番号による新規測点の選択; 地図表示オ

プションの変更(投影図法、海底地形と海岸線ファイル、

測点注釈のスタイル); 現在のコレクションの領域を定義。

 

データプロット・ポップアップメニュー (Data Plot Popup Menu)： 

 

現在のウィンドウの拡大、および Xと Yの範囲設定; 現在

のウィンドウのカラーバーを拡大、および Z の範囲設定; 
全データ値に対して現在または全てのウィンドウの X，Y
および Z の範囲の自動スケール; 現在のウィンドウのカラ

ーマッピング変更; 現在のウィンドウのディスプレイ・オプ

ション変更; X，Y と Z 変数を新たに選択 

 

2.4 ステータス行 (Status Line) 

 

ステータス行にはヘルプ、状況および進行情報が表示されます。ステータスバーの右端には現在のモー

ドと動作中の設定ファイルが表示されます。 

2.5 ポップアップ・ウィンドウ (Popup Windows) 

ポップアップ・ウィンドウは追加情報を表示します。ポップアップ・ウィンドウは ODV 画面の特定範囲(動作

領域上)にマウスを置くと自動的に現れ、その範囲から離れると消えます。ODV のポップアップ・ウィンドウ

の概要は次の表を参照して下さい。 

ポップアップ・ウィンドウ 動作範囲 表示内容 

コレクション変数 
(Collection variables)

テキストウィンドウの一行目

にある航海名の後にある測

現在有効な測点(地図の中に示される、Val)、現在

のクルーズ(Cru)、および現在の測点(Sta)のコレク
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点フィールド ションの変数とデータの有効率［％］のリスト 
選択基準 
(Selection criteria) 

テキストウィンドウの一行目

にある［］で囲まれた範囲 
現在の測点／サンプルの選択基準のリスト 

航海情報 
(Cruise information) 

テキストウィンドウの一行目

の “:”の後にある航海フィー

ルド 

現在の航海に関する情報の概要 

測点情報 
(Station information) 

テキストウィンドウの一行目

にある航海名の後にある測

点フィールド 

現在の測点のデータ有効率 

データの概要 
(Data summary) 

テキストウィンドウの二行目

と三行目の最初の項目(#ま

たは“surf”) 

現在のサンプルに関する全変数のデータ値(デー

タの品質はカラーで示される) 

データ情報 
(Data information) 

テキストウィンドウの二行目

および三行目のあらゆる変

数 

全変数ラベル、データ値、データ品質フラグ 

 

ODV ウィンドウを最大化すると(最大化するには右上隅の最大化ボタンを押します)、ODV グラフィクス・ウ

ィンドウは、メインまたは背景メニューの印刷コマンド、または PostScript ファイル(背景ポップアップメニュ

ーから Save as を選択)に書き出した時に得られる全画面ハードコピーを描画します。ODV アプリケーショ

ン・ウィンドウの大きさは、右上隅のリサイズ・ボタンを押すか、ウィンドウの境界をドラッグして任意に変更

できます。ODV グラフィクス・ウィンドウが小さいときは、スクロールバーを使うか、グラフィクス・キャンバス

の背景領域にマウスを置いてドラッグ(マウスの左のボタンを押したままマウスを動かす)して、表示範囲を

選びます。 

ODV は常に現在の測点を示します。現在の測点は地図上に赤い円で示され、一般的な情報はテキスト

ウィンドウの一行目に表示されます。新しい現在の測点を選択するには、地図上のその場所でマウスの左

ボタンをクリックしてください。現在の測点におけるサンプルの一つが現在のサンプルになります。現在の

サンプルのデータは、テキストウィンドウの二行目と三行目に表示され、現在のサンプルは赤い十字記号

でデータプロット(存在すれば)の中で印されます。新しい現在のサンプル(および現在の測点)は、どのデ

ータプロットの中からでも、データ点をマウスの左ボタンでクリックして選べます。 

現在の測点、全測点の散布図、カラー断面図または等値面分布図を(STATION, SCATTER, SECTION, 
SURFACE モードのそれぞれにおいて)プロットするには、各々の測点または地図内の任意の位置をダブ

ルクリックするか、p を押します。STATION モードでは、他の測点をダブルクリックするだけで、その測点

が追加されます。SECTION モードでデータプロットを表示するには、最初に断面を定義する必要がありま

す。 
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3 コレクションの作成 (Creating Collections) 

新しい ODV コレクションを作成するには、メインメニューから File>New の順に選択し、新たにコレクション

が作成するディレクトリを選んでコレクション名を指定します。その後でコレクションに保存される変数を定

義する必要があります。 

 

いくつか選択できます: 変数は手動で指定する

か 、 ODV が サ ポ ー ト す る フ ァ イ ル 形 式

(.txt, .var, .o4x または任意の拡張子の general 
spreadsheet ファイル)の変数、あるいは特定のプ

ロジェクトに共通の変数セット(例えば WOCE 
WHP, NODC World Ocean Database など)を使う

こととができます。 

手動で変数を定義するか、雛形ファイルから変数を導

入すると、最初の変数セットに対して追加や削除、変数

ラベルの編集、変数の表示順序の変更ができます。新

規に変数を追加するには、New Variable フィールドに

変数ラベルを入力して Add を押します。Delete または

Edit を押すと変数の削除またはラベルの修正ができま

す。変数ラベルを編集したときには、変更を適用するに

は Update ボタンを押して下さい。あいまいな表現を避

けるために、変数ラベルには常に単位を含めます(単位

は括弧[...]で括ります)。  

一番目のコレクション変数は、ODV の内部でデータの並び替えに使われる特別なものです。また、コレク

ション変数の最大数は 50 個です。 

下付き文字や上付き文字、特殊文字を表記するため、次の制御文字が変数ラベル内で使えます: 

~$ 記号フォント(ギリシャ文字)へ切り替える 
~# 通常のテキスト・フォントへ切り替える 
~% パーミル記号を生成する 
~^ 次の文字を上付きにする 
~_ 次の文字を下付きにする 

OK を押すと変数ラベルの定義は完了です。ODV はコレクションを作成して測点モードに切り替わり、初

期設定では全球地図を描画します。初期のコレクションは空です。コレクションにデータを読み込むため

には、メインメニューの Import を使用してください。 

海洋データのコレクションでは、水深、水温、塩分が、最初の三つの変数としてあらかじめ定義されていま

す。また、WOCE データファイルとは異なり、ODV では基本的に水深を使って変数を並び替えます。
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WOCE の圧力データは、読み込まれた時に水深に自動変換されます。圧力は導変数として ODV で定義

できます。 

3.1 コレクションファイルの概要 (Collection Files Summary) 

ここでは ODV コレクションを構成するファイルの概要について、その役割や目的の説明と合わせて示しま

す。通常、ユーザーがコレクションファイルの構造を知る必要はありませんが、これらの情報は問題や予期

せぬ事態に遭遇したときに役立つでしょう。 

コレクションデータは.var, .hob, .dob ファイルに保存されます。設定ファイル.cfg はデータを含みませんが、

地図領域、測点選択基準、ウィンドウのレイアウトのような、ユーザーがコレクション中のデータを眺める方

法の定義に関する設定を保存します。 

コレクションファイル 

拡張子 フォーマット 注釈 

基本ファイル  必須。手動で変更してはいけません。 
<col>.var アスキー コレクション変数、保存するコレクション名、測点数を定義。このファイル

は ODV 実行ファイルに関連付けられていて、例えば var ファイルをダブ

ルクリックすると各コレクションとともに ODV が起動します。 
<col>.hob バイナリ 測点のメタデータ(名前，位置，日時など)を保存。 
<col>.dob バイナリ 実際の測点データと品質フラグを保存。 
   
補助ファイル  存在しなければ、ODV が自動的に作成します。 
<col>.inv アスキー 航海毎に並べられたインベントリのコレクション 
<col>.cid バイナリ 航海 ID 番号 
<col>.log アスキー ログファイルのコレクション; データ変更の記録を保管。 
<col>.idv アスキー 導変数(水深、水温、酸素など)に対して入力に使用したキー変数の ID

リスト 
<col>.cfl アスキー 最新の設定ファイル名が含まれています。 
   
情報ファイル  オプション。ODV が netCDF データセットをオープンしたときに作成され

ます。 
<col>.info アスキー コレクションまたは netCDF データセットの説明(書式自由のテキスト)。 

上記の<col>で示されるファイル名はコレクション名から与えられます; 全てのファイルは同じディレクトリ[コ
レクション・ディレクトリ]に置かれなければなりません。 

設定ファイル 

拡張子 フォーマット 注釈 

<any>.cfg バイナリ 画面レイアウト、数値範囲、選択された導変数や等値面変数、その他の

設定を保存した設定ファイル。設定ファイルを持つコレクション名は cfg
ファイルの中に記録されます。別のコレクションがその cfg ファイルを使

用する場合にはいくつかの制約があります。 
<any>.sec アスキー 断面の概要と特性を保存。 
(上記の<any>で示される)ファイル名は任意です; これらのファイルは任意の場所に置けます。 
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3.2 Windows, UNIX, Mac X間の移動 (Migrating Between Windows, UNIX and Mac 
OS X) 

ODV マルチプラットフォーム・ソフトウェアで作成されたデータコレクションと設定ファイルはプラットフォー

ム(訳注: コンピュータの種類)に依存しないので、修正することなくサポートされている全てのシステム上で

使用できます。Windows および Solaris 向けの ODV version 4.0 またはそれ以降のバージョンで作成され

たデータコレクションと設定ファイルもサポートされています。 
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4 データの読み込み (Importing Data) 

4.1 ODVスプレッドシート・ファイル (ODV Spreadsheet Files) 

ODV は様々なスプレッドシート形式のアスキーファイルからデータを読み込めます。これらのファイルのデ

ータは、既存のデータコレクションに追加するか、新規コレクションの作成に使用できます。ODV は測点メ

タデータ情報やカラムのラベル情報の有無に関わらず、これらのファイルをサポートしています。カラムの

分離記号にはタブ、“;”、スペース、“/”が使え、任意の指定数字または空欄は欠測として扱われます。

General ODV スプレッドシート・フォーマットに関する詳細な説明は以下の表に示されています。 

ODV スプレッドシート・ファイルは多くの航海における多くの測点のデータを含むことができます。ある測

点における全観測層は連続した順番でなければなりませんが、必ずしも並び替えられている必要はありま

せん。Cruise(航海名), Station(測点名), Type(観測タイプ), mon/day/yr(日付), hh:mm(時刻), Lon (°E; 
東経), lat (°N; 北緯)の各項目のどれか一つでも変更があれば、ODVは新しい測点の開始であると解釈し

ます。 

General ODV スプレッドシート・ファイルを読み込む手順は次の通りです。以下で述べる、より制約のある

generic ODV スプレッドシート・フォーマットの読み込み手順は非常にシンプルで、ユーザーの操作はほと

んど必要ありません。 

General ODV スプレッドシート・ファイルから現在開いているコレクションにデータを読み込むには、

Import>SpreadSheet の順で選択し、読み込みたいデータファイルの指定には標準ファイル選択ダイアロ

グを使います。もしファイルフォーマットが generic ODV スプレッドシート・フォーマット(下記参照)とは異な

る場合、カラム分離記号と欠測値(この値を含んでいるか空のフィールドは欠測と見なされます)を選択す

るためのスプレッドシート・ファイル・プロパティのダイアログ・ボックスが現れます。また、カラムのラベルを

含む行(なければ空のまま)と最初のデータ行も指定できます。ODV は全項目に対して適切な初期値を与

えるので、多くの場合は変更の必要がありません。Column Sep. Character では、 Column Labels ボックス

の中にあるラベルのリストで与えられる記号を選んでください。全てのスプレッドシート・ファイル・プロパテ

ィがセットされれば OK を、読み込みを中止したいときは cancel を押して下さい。 

メタデータのカラム・ラベルが generic ODV スプレッドシート・フォーマット(下記参照)の仕様と異なる場合、

コレクションのメタデータ変数に入力カラムを関連付けるための、または入力ファイルでは提供されないこ

れらの変数に対して初期値を設定するための Header Variable Association ダイアログ・ボックスが現れま

す。すでに関連付けされている変数にはアスタリスク(*)が付いています。新しい関連付けを定義するには、

Source File と Target Collection のリストの中からそれぞれ項目を選んで Associate を押して下さい。読み込

み時に変換を行うには Convert を押して、利用可能な変換アルゴリズムを一つ選んで下さい。既存の関連

付けを削除するには、それぞれの変数を選択して Undo を押して下さい。読み込むファイルがコレクショ

ン・ヘッダー変数に関する情報を一つも含んでいない場合は、次のようにして初期値を設定できます: (1)
それぞれのターゲット変数を選択して; (2) Set Default を押して、 (3)初期値を入力してください。入力した

初期値の設定はファイル内の全データ行に使用されます。実行するには OK、読み込みを中止する時に

は Cancel を押して下さい。最後に読み込みオプションを指定して、OK を押すとデータの読み込みが始ま

ります。 

Generic ODV スプレッドシート・フォーマット(下記参照)と異なるファイルは、決して ODV デスクトップ・アイ

コンまたは開いている ODV ウィンドウにドラッグ&ドロップしないでください。 

4.1.1 General フォーマット (General Format) 
全般(General) アスキーコード 
ファイル拡張子(File extension) 任意 
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カラム(Columns) 

測点メタデータ情報と 50 個までの変数のデータ値は、分離されたカラ

ムに保存されます。一部あるいは全てのメタデータのカラムは存在しな

いかもしれません。メタデータとデータのカラムの並びは任意です。フ

ァイル中のカラムのラベルを含む行(存在した場合; 下記参照)と全デー

タ行のカラム数は同じでなければなりません。 

カラム分離記号 
(Column separation character) 

タブまたは ; またはスペースまたは / 
重要: 航海および測点ラベルにはカラム分離記号を含んではいけませ

ん。例えば、カラム分離記号としてスペースまたは / を使うと、ラベル 
“CFC [um/kg]”は二つに分割されてしまいます。 

カラム・ラベル行 
(Column labels line) 

1. 無い場合があります; あるならば、どのデータ行よりも前に置かれな

ければなりません。 
2. メタデータとデータのカラムのラベルは任意です。推奨するヘッダ

ー ・ ラ ベ ル は 次 の 通 り で す : “Cruise”, “Station”, “Type”, 
“mon/day/yr”, “hh:mm”, “Lon (°E)”, “Lat (°N)”, “Bot. Depth 
[m]”. 

3. データ変数のラベルは[ ]で括られる単位も含めて 60 文字までで

す。 
4. 各カラムのデータ変数は、オプションとして変数の直後に品質フラ

グを持つことができます。品質フラグのカラムのラベルは QF あるい

は QF:*のいずれかでなければなりません(*は任意の文字列)。 

データ行(Data lines) 

1. ファイルの任意の行から始まります。最初のデータ行に続く全ての

行は、同様にデータ行と仮定されます(ファイルの最後にコメントは

ありません!) 
2. 各行はメタデータと一つの観測層データを含んでいます。ある測

点の全観測層は連続していなければなりませんが、並び替えられ

ている必要はありません。一つの ODV スプレッドシート・ファイルに

は、多くの航海における多くの測点データを保存できます。 
3. 測点の「型」は一文字です(250 層より少ない測点は B(例えばボト

ル採水データ)、250層より多い測点は C(例えば CTDや XBTなど)
とします)。「型」に*を指定すると ODV が選択します。 

4. “Bot. Depth” (現場水深) がなければ、このフィールドは“0”(ゼロ) と
してください。 

5. 測点ヘッダー情報は(ヘッダー・カラムが含まれていれば)、全ての

行に存在しなければなりません。 

品質フラグ・カラム 
(Quality flag columns) 

1. ある変数のデータ品質情報が有効な場合は、この情報はその変

数の直後に記載します。 
2. 品 質 フ ラ グ は 一 桁 の 整 数 で す : 0=good, 1=unknown, 

4=questionable, 8=bad. 
欠測値(Missing data value)  空欄または良好なデータの範囲を越えた任意の数値。 
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上述の general ODV スプレッドシート・フォーマットに加えて、より制約のある generic ODV スプレッドシー

ト・フォーマットと呼ばれるものもあり、ユーザーの操作なしにデータを読み込むことができ、ODV デスクト

ップ・アイコンや開かれた ODV ウィンドウにドラッグ&ドロップできます。できるだけ generic ODV スプレッド

シート・フォーマットに従うようにしてください。Generic ODV スプレッドシート・フォーマットの詳細な仕様は

下の表の通りです。 

4.1.2 Genericフォーマット(Generic Format) 
全般 (General) アスキーコード 
ファイル拡張子(File extension) .txt 

カラム(Columns) 

測点のヘッダー情報(メタデータ)と 50 個までの変数のデータ値は、

分離されたカラムに保存されます。ヘッダーおよびデータのカラムの

並びは任意です。ファイル中の全ての行は同じカラム数でなければ

なりません。 
カラム分離記号 
(Column separation character) タブまたは ; 

一行目: カラム・ラベル 
(First line: Column Labels) 

1. カラムのラベルを含みます。 
2. 標準ヘッダー・ラベルは次の通りです : “Cruise”, “Station”, 

“Type”, “mon/day/yr”, “hh:mm”, “Lon (°E)”, “Lat (°N)”, 
“Bot. Depth [m]”. 

3. データ変数のラベルは[ ]で囲まれる単位も含めて 60 文字までで

す。 
4. データ変数の各カラムは、オプションとして変数の直後に品質フ

ラグを持つことができます。品質フラグのカラムのラベルは QF あ

るいは QF:*のいずれかでなければなりません(*は任意の文字

列)。 

二行目から最終行まで: データ行 
(2nd until last line: Data Lines) 

1. 各行はメタデータと一つの観測層のデータを含んでいます。測

点の全ての観測層は連続していなければなりませんが、並び替

えられている必要はありません。一つの ODV スプレッドシート・フ

ァイルには、多くの航海の多くの測点データを保存できます。 
2. 航海および測点のラベルは最大 20 文字までに限られています。

測点ラベルで数字を使用すると、高度な内部ソートや選択が容

易になるので推奨します。 
3. 測点の「型」は一文字です(250 層より少ない測点は B(例えばボ

トル採水データ)、250 層より多い測点は C(例えば CTD や XBT
など)とします)。「型」に*を指定すると ODV が選びます。 

4. “Bot. Depth” がなければ、このフィールドは “0”(ゼロ) としてくだ

さい。 
5. 測点ヘッダー情報は全ての行に存在しなければなりません。 

品質フラグ・カラム 
(Quality flag columns) 

1. ある変数のデータ品質情報が有効な場合は、この情報はその変

数の直後に記載します。 
2. 品 質 フ ラ グ は 一 桁 の 整 数 で す : 0=good, 1=unknown, 

4=questionable, 8=bad. 
欠測値(Missing data value) 空欄または –1.e10 
 

Generic ODV スプレッドシート・フォーマットのファイルの読み込みは、半自動的に ODV が処理します: ヘ
ッダー・カラムの指定にユーザーの操作は不要で、これらのファイルは ODV デスクトップ・アイコンまたは

開いている ODV ウィンドウにドラッグ&ドロップできます。 
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Generic ODV スプレッドシート・フォーマットから現在開いているコレクションにデータを読み込むためには、

Import>SpreadSheet の順に選択し、読み込みたいデータの指定にはウィンドウズ標準のファイル選択ダイ

アログを使用してください。読み込みオプションを指定して OK を押すとデータの読み込みが始まります。 

4.2 WOCE海洋観測データ (WOCE Hydrographic Data) 

WOCE 海洋観測データ(WHP Exchange フォーマット)を現在開いている ODV コレクションに読み込めま

す。まず初めに、WHP DAC (http://whpo.ucsd.edu/)からディスク上の空ディレクトリ(ソース・ディレクトリ)に
データファイルをダウンロードして下さい。ボトル採水データを読み込むには ODV のメインメニューから

Import>WOCE WHP Bottle(exchange format)>Single Fileの順に選択して下さい。ディスク上のWHPデー

タセットの選択には標準のファイル選択ダイアログを使用します(WHP Exchange ファイルの標準の拡張子

は.csv です; もしファイルの拡張子が違っていたら、ファイル選択ダイアログのファイル形式は “All files”を

選択してください)。読み込みオプションを設定して OK を押すと読み込みを開始します。ODV は WOCE
データファイルの全測点を読み込みます。ODVは実データに加えて WOCEデータの品質フラグも識別し

て読み込みます。これらの品質フラグは後の解析で不良または疑わしデータを取り除くフィルターとして

使えます。（地図ポップアップメニューから select critelia を選択(Sample Selection タブを選択)するとデータ

品質フィルターを修正できます。） 

CTD デ ー タ を 読 み 込 む に は 、 ODV の メ イ ン メ ニ ュ ー から Import>WOCE WHP CTD(exchange 
format)>Single File の順に選択し、読み込みたい CTD データが含まれている.zip ファイルを選択します。

必要ならばサブ・サンプリングデータを指定して下さい(初期設定ではサブ・サンプリングデータはありませ

ん)。ODV は.zip ファイルの圧縮を解いて現在開いているコレクションに CTD の全測点を読み込みます。

ODV は一測点あたり 20,000 層のデータを取り扱うことができます。測点がそれ以上のデータを持つ場合

は切り捨てられます。 

ODV はソースファイルの圧力データを水深値に自動変換します。もし変数として圧力データが必要な場

合は導変数 Pressure(Depth)を利用してください。 

4.3 WOD海洋観測データ (WOD Hydrographic Data) 

ODV で Import>World Ocean Database>Single File の順に選択すると、WOD 配布 CD の World Ocean 
Database ディレクトリまたはオンライン・データファイルからオリジナル海洋観測データを読み込むことがで

きます。読み込みたい WOD データセットの圧縮データファイル(*.gz)の指定には標準の Windows ファイ

ル選択ダイアログを使用してください(すでに圧縮を解かれた WOD ファイルを選びたいときはファイル形

式で “All Files (*.*)”を選んでください)。WOD の測点に合うように測点選択基準を指定するか、OK を押

すだけで、現在の地図領域に収まる全ての測点を読み込み、読み込みオプションを指定してから OK を

押すとデータの読み込みが始まります。ODV は選択された WOD のデータファイルを読み取って、測点の

選択基準を満たす全ての測点を読み込みます。読み込まれた測点の航海ラベルは WOD の識別子、 例
えば二桁の NODC 国コードと六桁の OCL クルーズ番号に続く “WOD98”、“WOD01”等で構成されてい

ます。ODVはユニークな(他と重複しない)OCLプロファイル番号を測点番号として使用します。ODVは読

み込みファイルに含まれるデータ品質フラグを認識して使用します。 

同じ測点選択基準と読み込みオプションを使って、一度の読み込み操作で複数の WOD ファイルからデ

ータを読み込むことができます。そうするには、読み込まれるファイル名(フルパス名で、一行につき一ファ

イル名 )を含むアスキーファイル (初期設定の拡張子は .lst)を用意する必要があります。そして

Import>World Ocean Database>Multiple File の順に選択し、WOD の測点に合う測点選択基準を指定し

(現在の地図領域内に収まる全ての測点を読み込む場合は OK を押すだけ)、さらに読み込みオプション

を指定して OK を押すとデータの読み込みが始まります。ODV はアスキーファイルに書かれた全ファイル

を読み取って、測点選択基準を満たす全ての測点を読み込みます。 
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現在の地図領域内に収まる測点だけがコレクションに読み込まれます。全測点を読み込むには、読み込

を開始する前に地図ポップアップメニューから Global Map を選択してください。 

4.4 WOA94海洋観測データ (WOA94 Hydrographic Data) 

ODV で Import>World Ocean Atlas 94>Single File の順に選択して World Ocean Atlas 1994 の配布 CD
からオリジナルの海洋データを直接読み込むことができます。読み込みたい WOA94 データセットのデー

タファイル(*.ol)の指定には、標準の Windows ファイル選択ダイアログを使用してください。WOA94 の測

点に合う測点の選択基準を指定し(現在の地図領域内に収まる全ての測点を読み込む場合は OKを押す

だけ)、さらに読み込みオプションを指定してから OK を押すとデータの読み込みが始まります。ODV は選

択された WOA94 データファイルを読み取って、測点の選択基準を満たす全ての測点を読み込みます。 

同じ測点選択基準と読み込みオプションを使って、一度の読み込み操作で複数の WOA94 ファイルから

データを読み込むことができます。そうするには、読み込まれるファイル名(フルパス名で、一行につき一

つのファイル名)を含むアスキーファイル(初期設定の拡張子は.lst)を用意する必要があります。そして

Import>World Ocean Atlas 94>Multiple Files の順に選択して、WOA94 の測点に合う測点選択基準を指

定し(現在の地図領域内に収まる全ての測点を読み込む場合は OK を押すだけ)、さらに読み込みオプシ

ョンを指定して OK を押せばデータの読み込みが始まります。ODV はアスキーファイルに記載された全フ

ァイルを読み取って、測点の選択基準を満たす全ての測点を読み込みます。 

現在の地図領域内に収まる測点だけがコレクションに読み込まれます。全ての測点を読み込むには、読

み込を開始する前に地図ポップアップメニューから Global Map を選択してください。 

4.5 SD2海洋観測データ (SD2 Hydrographic Data) 

ODV で Import>NODC SD2 Format>Single File の順に選択して NODC SD2 ファイルからオリジナルの海

洋観測データを読み込むことができます。読み込みたいデータファイルの指定には、標準の Windows フ

ァイル選択ダイアログを使用してください。読み込みオプションを指定して OK を押すとデータの読み込み

が始まります。 

複数の SD2 ファイルを読み込みたい時には、全ての SD2 ファイルを一つのディレクトリに置いて、読み込

みたい SD2 のファイル名を入力したファイルを作ってください(初期設定のリスト・ファイルの拡張子は.lst
で、一行につき一つのファイル名)。そして Import>NODC SD2 Forma>Multiple Files の順に選んでリスト・

ファイルを選択します。 

4.6 他の海洋観測データ (Other Hydrographic Data) 

読み込みたい海洋観測データが WOCE WHP, WOA94, NODC SD2 のいずれのフォーマットでもない時

は、上述した ODV スプレッドシート・フォーマットを使って ODV コレクションにデータを読み込ませることが

できます。旧バージョンとの互換性を保つために、長い航海ラベルと測点ラベルに加えて各々の実データ

値に対する品質フラグを認めている ODV4.x アスキーフォーマットを今でも ODV はサポートしています。

旧バージョンのODVを使っているユーザーは ODV3.0アスキー交換フォーマットを通してデータを変換で

きます。 

4.6.1 .o4x交換フォーマット (.o4x Exchange Format) 

“.o4x”アスキー交換フォーマットは単一ファイルのフォーマットです。変数の情報と同時に読み込まれる全

測点のデータ値および品質フラグは、一つのファイル(初期設定の拡張子は.o4x)に含まれます。このファ

イルは、データの型の情報と同様に変数の数およびラベルも最初に含んでいなければなりません(下記を
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参照するか、ODV サンプル・ディレクトリにある import4.o4x ファイルを参照して下さい(訳注: ODV (mp) 
Version 1.3a では$ODVMPHOME\samples\SampleFiles.zip の中に収録されています))。(下の例で見られ

る上と下の “....+.”行はルーラーを示していて、ファイルの一部ではありません) 。 

“.o4x”変数部,の例 

....+....1....+....2....+....3....+....4....+....5....+....6....  
ODV4.0 Listing 
 File Name: import4.o4x 
      Type: HYD 
     Nstat: 12 
 Variables: 8 
 
Depth [m]                                                    6.0 
Temperature [°C]                                             8.2 
Salinity [psu]                                               8.3 
Oxygen [~$m~#mol/kg]                                         6.0 
Phosphate [~$m~#mol/kg]                                      8.2 
Silicate [~$m~#mol/kg]                                       8.1 
Nitrate [~$m~#mol/kg]                                        7.1 
Nitrite [~$m~#mol/kg]                                        6.1 
....+....1....+....2....+....3....+....4....+....5....+....6....  
 

測点のヘッダー行とデータファイルの変数部は一つの空行で分けられています(例えば ODV サンプル・

ディレクトリにある import4.o4x ファイルを参照してください (訳注 : ODV (mp) Version 1.3a では

$ODVMPHOME\samples\SampleFiles.zip の中に収録されています))。測点のヘッダー行の一桁目は #で

始まります。これに続く項目は次の通りです: (1)測点の航海ラベル(3～22 桁目; a20); (2)測点ラベル(24～

43 桁目; a20); (3) 測点タイプ(B, C, X はそれぞれボトル採水、CTD、XBT データ; 45 桁目; a1); (4)日付

mm/dd/yyyy(47～66 桁目; i2, 1x, i2, 1x, i4); (5)東経(十進数; 58～64 桁目; f7.3); (6)北緯(十進数; 66～72
桁目; f7.3); (7)現場水深([m]; 74～78 桁目; i5); (8)最深観測深度([m]; 80～84; i5); (9)観測層数(85～89
桁目; i5); (10)ファイル内の変数の数(91～93 桁目; i3)。このファイルの例では、測点 06MT18/558 の型は

ボトル採水で、14 層の観測深度のそれぞれに 8 個の変数が続いています。これらの変数は、(ファイルの

初めにある変数部で定義されているような)第二ヘッダー部の変数の並びと一致しなければなりません(例
えば、1 なら水深を、6 ならケイ酸塩を意味します)。フォーマットの唯一の制約は、第二ヘッダー部の変数

番号が少なくとも一つの空白で区切られていなければならないことです。 

各観測水深(この例では 14 層)につき、一つのデータ行があります。これらの各行には、第二ヘッダー部

で示されている順に並んでいるデータ値と品質フラグが含まれていなければなりません。欠測値はデータ

ファイル中で-1.000E+10 とします。データと品質フラグとは少なくとも一つの空白で分けられていなければ

なりません。品質フラグは一桁の整数で、0=good, 1=unknown, 4=questionable, 8=bad を意味します。測

点の最終データ行の直後には、読み込まれる次の測点の(#で始まる)第一ヘッダー行が、あるいはそれ

が読み込まれる最後の測点ならば end-of-file(ファイルの終わりを示す記号)が続きます。 

“.o4x”ファイルを作成してから、ODV を実行させて新しいデータのためのコレクションを開くか作成して下

さい。そして Import メニューから ODV4.x Listing を選択して、上記で作成したアスキーデータファイルを読

み込みファイルとして選んで、読み込みオプションを指定して OK を押せばデータの読み込みが始まりま

す。その後 ODV は読み取りファイルにアクセスしてコレクションに測点を追加／統合します。ODV 上

に.o4x ファイルをドラッグ&ドロップすることもできます。 
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4.6.2 .o3x交換フォーマット (.o3x Exchange Format) 

“.o3x”交換フォーマットのデータを読み込むには、二つのアスキーファイルを用意する必要があります: 一
つは、読み込みたい全測点の実データを含んだもの(初期設定の拡張子は.o3x)、もう一つは、データファ

イルに含まれる変数を記述する(小さい)ファイルです(拡張子は.var でなければなりません)。 

“.var”ファイルの例 

....+....1....+....2....+....3....+....4....+....5....+....6.... 
ODV4.0 
Collection: SAVE 
      Type: HYD 
     Nstat: 0 
 Variables: 7 
 
Depth [m]                                                    6.0 
Temperature [°C]                                             8.2 
Salinity [psu]                                               8.3 
Oxygen [~$m~#mol/kg]                                         6.0 
Phosphate [~$m~#mol/kg]                                      8.2 
Silicate [~$m~#mol/kg]                                       8.1 
Nitrate [~$m~#mol/kg]                                        7.1 
....+....1....+....2....+....3....+....4....+....5....+....6.... 

 

上と下の“....+”行は単なるルーラーであって、.var ファイルの一部ではありません。また、.var ファイルは

ODV4.x コレクションの定義ファイルと同じフォーマットですが、データの読み込みに必要な情報は変数に

関する記載に限られます。読み込むデータファイルに含まれる変数の数の指定は、五行目の 13 桁目から

始めなければなりません。そして一つの空行の後に、全変数の変数ラベルと数値フォーマットを変数毎の

行で与える必要があります。数値フォーマットは 61 桁目から始まり、 ll.d の形式で表示されます(ここで ll
は文字列の全長で、d は小数点以下の桁数を示します)。 

“.o3x”ヘッダー行の例 

....+....1....+....2....+....3....+....4....+....5....+....6....+....7... 
# REID_ET           212 B  6/21/1967 243.167 -28.233  3400  3310   34   7 
    1    2    3    4    5    6    7 

 

読み込む全測点のデータは単独のアスキーファイルでなければなりません(初期設定の拡張子は.o3x)。
このファイルは以下のフォーマット仕様と一致しなければなりません(最上部のルーラーはファイルの一部

ではありません): 

ファイルは読み込む最初の測点のヘッダー行から開始します。測点ヘッダー行は一桁目の#から始まらな

ければなりません。各項目は以下の通りです: (1)測点の航海ラベル(3～12 桁目、a10); (2)測点ラベル(14
～23 桁目、a10); (3)測点タイプ(B, C, X はそれぞれボトル採水、CTD、XBT データ; 25 桁目; a1); (4)日付

mm/dd/yyyy(27～36 桁目; i2, 1x, i2, 1x, i4); (5)東経(十進数; 38～44 桁目; f7.3); (6)北緯(十進数; 46～52
桁目、f7.3); (7)現場水深([m]; 54～58 桁目; i5); (8)最深観測層深度([m]; 60～64 桁目; i5); (9)観測層数

(66～69 桁目; i4); (10)ファイル内の変数の数(71～73 桁目; i3)。上述の例では、測点 REID_ET/212 で測
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点の型はボトル採水、34 層の観測深度のそれぞれに 7 個の変数のデータが続いています。これらの変数

は.var ファイルの第二ヘッダー部にある変数の並びと一致しなければなりません(例えば、1 なら水深を、6
ならケイ酸塩を意味します)。フォーマットの唯一の制約は、第二ヘッダー部の変数番号が少なくとも一つ

の空白で区切られていなければならないことです。 

各観測深度(上述の例では 34 層)について、一つのデータ行が続かなければなりません。これらの各行は、

第二ヘッダー部で示されている順に並んだ数値が含まれなれなければなりません。欠測値はデータファ

イル中で-1.000E+10 とします。ある測点の最終データ行の直後には、読み込まれる次の測点の(#で始ま

る)第一ヘッダー行が、あるいはそれが読み込まれる最後の測点ならば end-of-file(ファイルの終わりを示

す記号)が続きます。 

“.var” と “.o3x” ファイルを作成した後は、ODV を実行して新しいデータのためのコレクションを開くか作成

して下さい。そして Import メニューから ODV3.x Listing を選択して、上記で作成したアスキーデータファイ

ルを読み込みファイルとして選び、読み込みオプションを指定して OK を押せばデータの読み込みが始ま

ります。その後 ODV は読み取りファイルにアクセスしてコレクションに測点を追加／統合します。ODV3.0
交換フォーマットからデータを読み込んだときのデータ品質フラグは Unknown にセットされます。 

4.7 読み込みオプション・ダイアログ (Import Options Dialog) 
データを読み込む時には

Import Options ダイアログが

現れ、データ読み込み時の

動作を定義するようユーザ

ーに促します。 

 

Import Mode 

Add/Replace Station Data: コレクションに読み込みファイルのデータを追加したい時に選択してください。

Check for Existing Stations ボックスがチェックされていると、ODV は同じ名前、日付、位置を持つ測点を

コレクションから検索し、そして(もし見つかれば)コレクション中の既存の測点を読み込みファイルの新し

い測点と入れ替えるための許可を問い合わせてきます(測点検索手順の詳細は下記の Cruise Label 
Association を参照)。 

Merge Data (selected variables): 一つ以上の変数(結合する変数)のデータを追加して、他の変数の既

存データは変更したくない時に選んでください。ある層の 「結合する変数(merge variable)」の「結合値」

は、下の表のように既存値か新規値かによって変わります: 
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既存値 
(Existing value) 

新規値 
(New value) 

結合値 
(Merged value) 

Yes yes 既存値と新規値との平均値 
Yes no 既存値 
No yes 新規値 
No no 欠測値 

Check for Existing Stations ボックスは、このモードの時は選べません。データを追加する前に、ODV は

一致する測点をコレクションから検索し(測点検索手順の詳細は下記の Cruise Label Association を参

照)、もし見つかれば、コレクションからオリジナルの測点を読み取って、選択された変数のデータを追

加し、オリジナルの測点を更新されたものと入れ替えます。一致する測点が見つからなければユーザ

ーに通知されます。 

Update Data (selected variables): 一つ以上の変数(更新する変数)のデータを更新して、他の変数の既

存データは変更したくない時に選択してください。ある層における「更新する変数(update variable)」の

「更新値」は新規の変数値だけに依存し、既存値は破棄されます。Check for Existing Stations ボックス

はこのモードでは選択できません。データを追加する前に、ODV は一致する測点をコレクションから検

索し(測点検索手順の詳細は下記の Cruise Label Association を参照)、もし見つかれば、コレクションか

らオリジナルの測点を読み取り、選択された変数のデータを更新して、オリジナルの測点を更新された

ものと入れ替えます。一致する測点が見つからなければユーザーに通知します。 

Cruise Label Association 

データの入れ替えや結合の際に、ODV はまず初めに読み込まれる測点と一致する既存の測点をター

ゲット・コレクションから検索する必要があります。この検索では航海名、測点名、測点タイプ、緯度・経

度、日付を比較します。一致の条件は航海名を除く全項目が同じことです。航海名については、Target
と Source のコンボ･ボックスを用いて別名を作成することができます。例えば、06MT15/3 という既存のコ

レクションの測点と METEOR15/3 という航海名の読み込みファイルの測点が同じであれば、まず Target
コンボ･ボックスから 06MT15/3 を選択して、それからソース・フィールドに METEOR15/3 と入力して別名

を設定することができます。ソース・フィールドのデフォルト値はターゲット名と同じなので、読み込みフ

ァイル名と既存コレクションの航海ラベルが同じ場合には、Cruise Label Association で全てを修正する

必要はありません。 

Variable Association 

通常、読み込みファイルに保存されている変数の数、並び、意味は、コレクションのそれらとは異なるの

で、変数のソース／ターゲットを関連付けしなければなりません。ODV はラベル(名前と単位)が一致す

れば自動的に変数を関連付けます。関連付けられた変数には*が付き、その変数をクリックすれば関連

付けられた変数が判ります。 

手動で変数を関連付けるには、ソース変数をクリックしてから、そのソース変数に関連付けたいターゲッ

ト変数をクリックし、Associate または Convert のいずれかのボタンを押します。読み込みファイルのデー

タ値を無修整で読み込む場合には Associate を使用し、読み込み中に単位の変換が必要な場合には 
Convert を使用して下さい。Convert を使うと、あらかじめ定義された共通の変換の中から選ぶことができ、

自ら定義した一般的な線形変換式も確立することもできます。 

ODVスプレッドシートを読み込むとき、読み込みファイル中のソース変数に対応しないターゲット変数を

初期設定値として設定ができます。これは、例えば三つのカラム X/Y/Z を含んでいるアスキーファイル

からある数量 Z の経緯度座標を読み込みたいが、指定した表面または水深が含まれていない場合に

役立ちます。ターゲット変数にデフォルト値をセットするには、まず初めに Target Collection リストの中か
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ら変数を選びます。次に Use Default ボタンを押して、このターゲット変数にふさわしい初期設定値を入

力して下さい。このターゲット変数には+が付きます。指定した値は、この操作によって読み込まれるあ

らゆる測点のあらゆる観測層で使用されます。 

ターゲット変数に関連付けられないソース変数はコレクションに読み込まれません。コレクションにデー

タを追加したければ、コレクションに追加したい変数だけを関連付けして下さい。どの ODV コレクション

でも第一変数には関連付けが必要です。 
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5 データの出力 (Exporting Data) 

5.1 スプレッドシート・ファイル (Spreadsheet Files) 

ODVのメインメニューから Export>ODV SpreadSheetの順に選択すると、単独のアスキースプレッドシート・

ファイルに現在選択している測点データを出力できます。出力ファイルに含めたい変数を選択し(初期設

定では全変数)、標準ファイル選択ダイアログ・ボックスを使って出力するディレクトリとファイル名を指定し

ます。スプレッドシート・ファイルは Import>ODV SpreadSheet を使用して再読み込みが可能です。また

ODV スプレッドシート名にはスペースや “\”, “/”, “:”の文字を含めないでください。 

5.2 ODVコレクション (ODV Collection) 

ODV のメインメニューから Export>ODV Collection の順に選択すると、新しい ODV コレクションに現在選

択している測点のデータを出力できます。新規コクションに含めたい変数を選択し(初期設定では全変数)、
標準ファイル選択ダイアログ・ボックスを使って出力するディレクトリとファイル名を指定して下さい。ODVコ

レクション名にスペースや “\”, “/”, “:”の文字を含めないでください。 

5.3 アスキーリスト (ASCII Listings) 

ODV のメインメニューから Export>ODV ODV4.x Listing の順に選択すると、単独のアスキーリストファイル

に現在選択している測点のデータを出力できます。出力ファイルに含めたい変数を選択し(初期設定では

全変数)、Windows 標準のファイル選択ダイアログ・ボックスを使って出力するディレクトリとファイル名を指

定してください。ODV4.xリスト・ファイルは Import>ODV4.x Listingを使って再読み込みできます。ODV4.x
リスト・フォーマットのより詳細な情報を見るにはここをクリックして下さい。ODV リスト・ファイル名にスペー

スや “\”, “/”, “:”の文字を含めないでください。 

5.4 プロット値の出力 (Exporting Plot Values) 

後々の処理(平均化、グリッド化、等値化など)のために、ODV のメインメニューから Export>Export Plot 
Values の順に選択して、ODV プロット・ウィンドウに表示されたデータ値をアスキーファイルに出力できま

す。この出力データを識別する説明文(txtID)を入力して OK をクリックしてください。ODV はローカル

ODV ディレクトリ(通常<home>\odv_local)の下に export\txtID の名前でサブディレクトリを作成します。出

力される全ファイルは、このディレクトリに書き込まれます。既に同じファイルが存在する場合、ODV は続

ける前にディレクトリから全ファイルを削除する許可を問い合わせてきます。出力ファイル名は “win?”(ここ

で “?”は各々のウィンドウの番号を表す)から始まります。実際の x-y-z-sigma_z データは、win?.oai ファイ

ルにあります(一行につき一点のデータ)。 

グリッド・フィールドのウィンドウでは、ODV はグリッド化処理(win?.oao ファイル)の結果も出力します。 
“.oao”ファイルのフォーマットは次の通りです: 

0 (無視) 
nx  ny ( x と y のグリッド・ポイント数) 
... nx X-grid values ... (X グリッドの位置) 
... ny Y-grid values ... (Y グリッドの位置) 
... nx*ny gridded values ... (評価フィールド、最初に Y グリッド値から始まる X 行×Y 行) 
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6 導変数 (Derived Variables) 

コレクションファイルに保存される基本変数に加えて、ODV では非常に多くの導変数(derived variables)を
計算でき、(一度定義すれば)基本変数と同様に解析やデータプロットに使用できます。導変数には次の

三種類があります: 

 組込導変数(built-in derived variables): 多くの一般的な海洋物理・海洋化学のパラメータが含ま

れています。 
 マクロファイル(macro files): ユーザー定義による数式がファイルに保存されたもので、任意の

ODV コレクションで使用できます。 
 数式(expressions): ユーザーが「その場(on-the-fly)」で定義するもの、現在のコレクションだけに

使われます。 

導変数を定義または削除するには、背景ポップアップメニューから Derived Variables を選択するか、ある

いはメインメニューから Configuration>Derived Variables の順に選択してください。マクロを追加するには

Choices リストからマクロファイルを選んで下さい; ユーザー定義済みの数式の追加には Expression を選び

ます。組込導変数の追加は Choices リストのその他の項目を選んで下さい。 

6.1 組込導変数 (Built-in Derived Variables) 

任意の基準圧力からのポテンシャル温度やポテンシャル密度、中立密度、Brunt-Väisälä (ブラント─バイ

サラ)周波数、力学的高度など海洋物理学で一般的に用いられている多くのパラメータのアルゴリズムが

ODV には組み込まれており、その場(on-the-fly)で計算や解析ができます。これらに加えて、海洋化学に

関する多くの変数や、例えば鉛直積分や微分のような有益な数学計算機能もあります。利用可能な組込

導変数のリストは以下の通りです。 

組込導変数の定義および削除には背景ポップアップメニューから Derived Variables を選択してください。

ODV は利用可能な定義済み導変数のリスト・ボックスを表示します。導変数を追加するには Choices リスト

で項目を選んでクリックするか Add を押すか、その項目をダブルクリックします。ポテンシャル温度やポテ

ンシャル密度のような一部の変数では追加情報が求められます(例えば基準圧力)。この情報を入力して

OK を押してください。飽和酸素のような他の導変数では、適切な入力変数の識別が求められます。導変

数の削除には、Already Defined リスト・ボックスにある変数をクリックして、Delete を押すか、削除したい項

目を単にダブルクリックしてください。他の導変数から入力を求められている変数を削除するときには、こ

れらの数量も同様に削除されてしまいます。 

組込導変数のリスト(List of built-in derived variables) 

変数(Variable) コメント(Comment) 
AOU [umol/kg] Apparent oxygen utilization 
Brunt-Väisälä frequency [cycl/h] EOS80 
CFC-11 Saturation [%] Warner & Weiss, Deep Sea Res., 32,1485-1497,1985 
CFC-12 Saturation [%] Warner & Weiss, Deep Sea Res., 32,1485-1497,1985 
CFC-10 Saturation [%] Bullister & Wisegarver, Deep Sea Res., 45,1285-1302,1998 
CFC-113 Saturation [%] Bu & Warner, Deep Sea Res., 42,1151-1161,1995 
CH4 Saturation [%] Wiesenburg & Guinasso, J. Chem. Eng. Data, 24, 356-, 1979 
CO2 (TCO2, TALK) [umol/kg] Dickson and Goyet, DOE Handbook, 1991 
CO3

- - (TCO2, TALK) [umol/kg] Dickson and Goyet, DOE Handbook, 1991 
Day of Year (header mon/day/year) 
[days] 

Day of the Year [days] derived from header mon/day/year 
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Day of Year (time variable) [days] Day of the Year [days] derived from a time variable 
Difference from Reference Data (details) 
Dynamic Height [dyn m] EOS80 (any reference pressure) 
Freezing Temperature [°C] F.Millero, UNESCO Tech. Papers in the Marine Science, No. 28., 

29-35, 1978 
HCO3

- (TCO2, TALK) [umol/kg] Dickson and Goyet, DOE Handbook, 1991 
Latitude  
Longitude  
Neutral Density [kg/m3] Jackett & McDougall, J. Phys. Ocean., 237-263, 1997 
Oxygen Saturation [%] Weiss, Deep Sea Res., 17, 721-735, 1970 
pCFC-11 [pptv] Warner & Weiss, Deep Sea Res., 32,1485-1497,1985 
pCFC-12 [pptv] Warner & Weiss, Deep Sea Res., 32,1485-1497,1985 
pCFC-10 [pptv] Bullister & Wisegarver, Deep Sea Res., 45,1285-1302,1998 
pCFC-113 [pptv] Bu & Warner, Deep Sea Res., 42,1151-1161,1995 
pCH4 [ppbv] Wiesenburg & Guinasso, J. Chem. Eng. Data, 24, 356-, 1979 
pCO2 (TCO2,TALK) [uAtm] Dickson and Goyet, DOE Handbook, 1991; Weiss 74 
pH (TCO2,TALK)  Dickson and Goyet, DOE Handbook, 1991 
Potential Density [kg/m3] EOS80 (any reference pressure) 
Potential Temperature [°C] Bryden, Deep Sea Res., 20, 401-408, 1973 (any reference pressure) 
Pressure [db] Saunders, J. Phys. Ocean., 1981 
Ratio Any two variables 
Sound Speed [m/s] Chen & Millero 1977, jasa, 62, 1129-1135 
Specific Heat Cp [J/(kg °C)] F. Millero et al, J. Geoph. Res., 78, 4499-4507, 1973 
Time (header mon/day/year) [yr] Decimal time [yr] derived from header mon/day/year 
Time (time variable) [yr] Decimal time [yr] derived from a time variable 
Vertical Derivative Any variable 
Second Vertical Derivative Any variable 
Vertical Integral Any variable 

 

鉛直積分(Vertical Integral): 

ユーザーは、鉛直積分を計算する変数を選択し(以降では A とする; 基本変数または定義済み導変数

が使用可能)、積分の開始水深 z0 を指定します(初期設定: 0m)。ある測点の各観測層に対し、ODV は 
z0 から各々の層までの積分 A×dz を計算します。積分の単位は、数量 A の単位×長さ(ODV では km
を使用)です。体積濃度単位(例えばモル／立方メートル)の変数の積分は“standing stock per square 
meters”(例えば単位水柱中のモル総量)になります。定義によっては z0 の積分値がゼロになります。

（例: 水柱の海面から 500m までの塩分の構成物質(salt content)を求めるには、積分の変数として塩分

を選択し、開始値には 0 を使用します。それから (近傍点の間で内挿によって)500m での鉛直積分値を

調べるか、SURFACE モードにおける等値面変数のように水深=500 での積分を定義してください。 

6.2 導変数のマクロ (Macros of Derived Variables) 

ある層における新しい導変数の値が、そこと同じ層の他の変数だけに依存するのであれば、組込量のリス

トには含まれていない新しい導変数を実装できます。このような場合は、マクロファイルに入力変数と新し

い組込量の式を指定してください。マクロファイルの拡張子は.mac で、ODV マクロ・ディレクトリ(通常は

c:\Program Files\Ocean Data View (mp)\Include\Macros)に置かれなければなりません。また、フォーマット

は以下の仕様に従っている必要があります。マクロの定義を簡単にするために ODV マクロ・エディタが使

えます(Utilities>Invoke Macro Editor で呼び出します)。ODV と共に配布されている実例マクロファイルは

独自に定義するためのサンプルファイルとして使えます。 
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マクロ導変数を使うには背景ポップアップメニューから Derived Variables を選んで、利用可能な数量のリ

ストから Macro Fileを選択してください。そして ODVマクロ・ディレクトリ(通常は<home>\odv_local\macros)
の中にあるマクロファイルを一つ選んで、新しい数量の計算に必要な変数を指定してください。必要な変

数の内の一つでも利用できなければ Cancel を押してマクロファイルのセットアップを中止して下さい。 

6.2.1 マクロ・エディタ (Macro Editor) 

Ocean Data View マクロファイルは Utilities>Invoke Macro Editor オプションを使って作成編集できます。

既存のマクロファイルを選択するか新規マクロ名を選んで、下記に示した手順に従ってマクロを定義して

ください。 

マクロ変数 (Macro Variable) 

ラベル(Label): マクロ変数のラベルと単位を入力します。次の整形文字が使えます: 

~$           記号フォント(ギリシャ文字)へ切り替える 
~#           通常のテキスト・フォントへ切り替える 
~%          パーミル記号を生成する 
~^           次の文字を上付きにする 
~_           次の文字を下付きにする 

フォーマット(Format): ODV テキストウィンドウに数値フォーマット(フィールド長と小数点以下の桁数)を入

力 

コメント(Comments) 

マクロ変数を説明する一行以上のコメントを入力する。 

入力変数(Input Variables) 

マクロ変数に必要な入力変数のリスト。入力変数の追加には、New フィールドにそのラベルと単位を入力

して “<<”ボタンを押してください(上述の整形文字が使えます)。定義済み入力変数を削除するには、

Defined リスト・ボックスの中からそれを選んで、“>>”ボタンを押して下さい。ODV マクロは最大 9 個の入力

変数を扱えます。 

数式(Expression) 

数式フィールドには、マクロ変数の計算を実行する演算を指定します。 

基本的な算術演算子 + - * / **、平方根 sqrt 、先行する二つの被演算子の最大または最小をとる min と 
max 、自然対数 ln 、指数関数 exp 、正弦 sin と余弦 cos (引数はラジアン)が使えます。Hewlett-Packard
の計算機のように(被演算子を演算子より先行させて)マクロ式を入力してください。例えば、#1 は一番目

(#1)の入力変数値を参照します。記号%t, %d, %x, %y は、それぞれ観測時刻(1900 年からの年; 例え

ば%t=84.4877 は Jun/27/84 を示します)、年における日数、東経、北緯を参照します。個々の項目(被演算

子と演算子)は少なくとも一個の空白で区切って、必要ならば次の行に続けてマクロ式を定義してください。

演算式の定義の総文字数は 500 までです。 

6.2.2 ODV マクロフォーマット(ODV Macro Format): 

マクロファイル po.mac の例: 
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ODV4.0 Macro 
>|--->----------------------------------------------------------|>--| 
     PO [~$m~#mol/kg]                                             5.0 
#1   Phosphate [~$m~#mol/kg] 
#2   Oxygen [~$m~#mol/kg] 
 
135 #1 *  #2 + 
 

ODV マクロファイルの最初の行は文字列 ODV4.0 Macro で、識別の目的にのみ使用されます。二行目は、

ファイルの残りの行を容易に整形するためのルーラーです。新規導変数の実際の定義は三行目から始ま

り、六桁目から新しい変数のラベルが置かれ、ODV テキストウィンドウでの表示は 66 桁目から始まる数値

フォーマット ll.d に従います。ここで ll はテキストフィールドの長さを、d は小数点以下の桁数を表します。

以降は、新規変数の計算に使われる他の(基本または定義済み導)変数が一行につき一個づつ続きます。

これらの行は、一桁目の#に続く一桁の数字(1, 2 , ...9 の順)で始まります。 使用される数量を説明する名

前を六桁目から入力してください。変数ラベルには制御文字として上述したギリシャ文字、上付き文字、

下付き文字が使えます。 

一つの測点の各観測層に対して実行される代数演算の実際の定義は、計算に使われる変数のブロックと

一つの空行で区切られます(上述のマクロファイルの例を参照)。基本算術演算子 + - * / **, 先行する二

つの被演算子の最大または最小をとる min と max、自然対数 ln、指数関数 exp、正弦 sin、余弦 cos (引
数はラジアン)が使用可能です。Hewlett-Packard の計算機のように(被演算子を演算子より先行させて)マ
クロ式を入力してください。例えば、#1 は一番目(#1)の入力変数値を参照します。記号%t, %d, %x, %y
は、それぞれ観測時刻(1900 年からの年; 例えば%t=84.4877 は Jun/27/84 を示します)、年における日数、

東経、北緯を参照します。個々の項目(被演算子と演算子)は少なくとも一個の空白で区切って、必要なら

ば次の行に続けてマクロ式を定義してください。演算式の定義における全文字数は 500 までです。ODV
で同時に動作するマクロの最大数は 10 個です。 

数量 PO = 135 * PO4 + O2 を計算する上述の例において、数列 135 #1 * は 135 と現在の層の第一変数

値との積を生成します。一度実行すると、数列 135 #1 * は掛算の結果に置き換えられ、それから第二変

数の値が加えられます。一つ以上入力変数が計測されていなければ、導変量の値には-1.e10(欠測値)が
セットされます。 

ODV のマクロ機能は広範囲に適用できるように一般化しています。以下に二つの例を示します。 

(a) t0 を基準とした放射性トレーサーの減衰(ここでは t0=1980; τ=17.6 年とします): 

T(t0) = T(t) e(t - t0)/τ 

ODV4.0 Macro 
>|--->----------------------------------------------------------|>--| 
     Trit80 [TU]                                                  7.2 
#1   Tritium [TU]  
 
%t 80 - 17.6 / exp #1 * 
 

(b) 水塊特性の複数のパラメータ距離(ここではポテンシャル水温、塩分、ケイ酸塩を使用): 

C = {(c - c0) / σ }2  + ... 
ODV4.0 Macro 
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>|--->----------------------------------------------------------|>--| 
     MP-Dist{10,34.7,25}                                          7.0 
#1   Tpot [C] 
#2   Salinity [psu] 
#3   Silicate [umol/kg] 
 
#1 10   - 0.1  / 2 **  
#2 34.7 - 0.05 / 2 ** + 
#3 25   - 0.5  / 2 ** + 
 

6.3 数式 (Expressions) 

数式はマクロに似ていて、同じ機能セットを使用し、ほとんど同じ方法で定義できます。数式の定義がファ

イルに保存されないことがマクロと大きく違う点で、また、数式は編集できません。数式は、新しく考案した

導数量(derived quantities)を素早くチェックするのに適しています。数式の適用範囲は定義済みのコレク

ションに限られています。数式が複雑な場合、または同じ数式を異なる多くのコレクションに対して使いた

い場合はマクロファイルを作ってください。 

 

導変数の数式をセットアップするには、背景ポップアップメニューから Derived Variables を選択し、利用可

能な数量のリストから Expression を選んで Add を押してください。すると ODV はマクロエディタ・ダイアログ

と同様のダイアログを表示します。ここで、ラベルフィールドに新規変数のラベルと単位を入力してくださ

い。それから新規変数に必要な入力変数を選びます; 例えば変数を Choices リストから変数を選んで “<-”
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を押します。最後に新しい数量を評価する数式を指定して下さい。基本算術演算子 + - * / **, 先行する

二つの被演算子の最大または最小をとる minとmax、自然対数 ln、指数関数 exp、正弦 sin、余弦 cos (引
数はラジアン)が使用可能です。Hewlett-Packard の計算機のように(被演算子を演算子より先行させて)マ
クロ式を入力してください。例えば、#1 は一番目(#1)の入力変数値を参照します。記号%t, %d, %x, %y
は、それぞれ観測時刻(1900 年からの年; 例えば%t=84.4877 は Jun/27/84 を示します)、年における日数、

東経、北緯を参照します。個々の項目(被演算子と演算子)は少なくとも一個の空白で区切って、必要なら

ば次の行に続けてマクロ式を定義してください。数式定義の総文字数は 500 までです。新しい数式のセッ

トアップを完了させるには OK を押して下さい。 

数式は編集できません。もしアルゴリズムを修正したければ、古い数式を削除してから新しい数式を定義

しなければなりません。 
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7 ODVの使用 (Using ODV) 

7.1 現在のサンプルおよび測点の選択 (Choosing Current Sample and Current 
Station) 

ODV でコレクションを開いて測点図が描かれた時、地図上に示される有効な測点の一つが現在の測点

です。この測点は赤丸で印されて、ヘッダーとデータ情報が ODVのテキストウィンドウに表示されます。新

しく現在の測点を選択するにはいくつかの方法があります: 

(1) 地図上の任意の測点をマウスの左ボタンでクリックする。同じ位置に複数の測点があるときは(リピ

ート観測、係留観測など)、シフトキーを押しながらマウスの左ボタンをクリックしてください。すると

ODV は一致する測点のリストを表示するので、そのリストから一つを選んでください。シフトキーを

押していなければ、初期設定によって最初に一致した測点が選ばれます。 
(2) 地図ポップアップメニューから Select Station by Name を選んで、航海ラベル、測点ラベル、測点タイ

プを指定します。 
(3) 地図ポップアップメニューから Select Station by Number を選んで(または単に#を押して)、測点の内

部連続番号を指定します。 

右矢印キー(->)を押すと次の有効な測点に進み、左矢印キー(<-)を押すと前の測点に戻ります。 

現在の測点におけるサンプルの一つが現在のサンプルとなり、このサンプルのデータ値は ODV テキスト

ウィンドウの三行目に表示されます。画面上にデータプロットがあれば、現在のサンプルもまた各プロット

中に赤の十字記号で印されます。同じ測点の深い方または浅い方の新しいサンプルは up/down と

PgUp/PgDn キーを押して選べます。または単にマウスの左ボタンでクリックして、データプロットの任意の

データ点を現在のサンプルにできます。 

テキストウィンドウの二行目または三行目の上にマウスを動かすと、品質フラグを含むデータ値の詳細な

情報が得られます。テキストウィンドウに表示される変数の数値フォーマットと順序はテキストウィンドウ・ポ

ップアップ・メニューの Variables Settings で変更できます。 

7.2 変数設定の変更 (Changing Variable Settings) 

ODV テキストウィンドウの三行目に表示される変数のラベル、最小／最大領域の初期設定、数値フォー

マット、位置は、テキストウィンド・ポップアップメニューの Variables Settings オプションを使って変更できま

す(テキストウィンドウ上でマウスの右ボタンをクリックして Variables Settings を選択してください)。 

最初に Variable コントロールを使って修正したい変数を選択します(右クリックをしたときに各々の変数上

にあれば、この変数があらかじめ選択されていることになります)。そして、この変数の異なるプロパティを

修正して下さい。Label 項目を編集すると、変数ラベルと単位の文字列が変更されます。単位は括弧[ ]で
括ってください。Minimum と Maximum の項目を設定すると、変数の上限と下限の初期設定値を変えられ

ます。Format 項目を設定すると、テキストウィンドウの三行目にある変数のリストデータで使われる数値フ

ォーマットを修正できます。最初の数字でフィールドの長さ(文字数)を指定し、二番目の数字で小数点以

下の桁数を指定します。最後に、Position コンボボックスを使ってテキストウィンドウの変数の位置を変更

できます(変数の新しい位置が選択できます; 例えば(現場)水温の次にポテンシャル水温)。引き続き他の

変数を変更し(Variable コンボボックスを使って選択します)、OK を押して実行して下さい。 
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7.3 選択基準の変更 (Changing Selection Criteria) 

 

測点図を描画するとき、ODV はコレクション中の各測点をチェックして、現在の測点選択基準を満たすか

どうかを調べます。このチェックを通過した測点だけが有効とみなされ、これらだけが地図上に表示されて

以降の閲覧やプロットに使用されます。測点およびサンプルの選択基準を修正するには地図ポップアッ

プメニューの Selection Criteria あるいはメインメニューの Configuration>Selection Criteria を使ってくださ

い。それぞれのタブ、例えば Name/Range, Date/Time, Availability，Sample Selection をクリックして修正し

たいカテゴリーを選択し、様々な項目を設定します。 

Name/Range タブでは、航海ラベルの選択、航海ラベルのワイルドカードの指定、測点ラベルの範囲の指

定、測点タイプの選択、内部順番号の範囲の設定、現場水深と深層部の観測の範囲を設定できます。航

海ラベルに関するワイルドカード・パタンとして以下の文字を指定できます: 

 c 自分自身を意味する任意の文字。すなわち c は文字 c に合致します。 
 ? 任意の一文字に合致。例: SAVE_LEG?. 
 * 0 文字以上の任意の文字に合致。例: I01_*, *06AQ* 
 […] かぎ括弧内に表された文字列のセット。文字クラスの中では逆スラッシュは特別な意

味を持ちません。例: [abc], [A-W], [0-9], I05[EW]_316N145_? 

Domain カテゴリーでは、各々の緯度経度の数値を指定して地図の矩形の副領域を定義できます。また

は Zoom ボタンを押して拡大する矩形を定義できます。Polygon ボタンを押してマウスで多角形の頂点を

入力すると、その多角形を有効な領域として定義できます。多角形は自動的に閉じられます。Availability
カテゴリーでは、測点が有効と見なされるために存在しなければならない一つ以上の変数を印します。

Sample Selection カテゴリーでは、指定した変数(Validate Variable)の範囲の指定、またはデータ品質レベ

ルの要求によるデータ品質フィルターを設定できます。Validate Variable に関して、ある範囲外の値を持

つ全てのサンプルは除外されます。カテゴリーの選択基準を緩和するには、各々のページの Relax 
Criteria ボタンを押してください。設定が完了したら OK を押します。ODV は新しい選択基準を用いて測

点図を再描画します。 
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7.4 地図投影法の変更 (Changing Map Projections) 

地図ポップアップメニューの Display Options を使って地図投影法を変更できます。Genera タブを選択し

て、Map Projection コンボボックスから投影法を一つ選んでください。次の投影法が利用可能です: (1)初
期設定の投影法, (2)正射図法(北極)(Orthographic (North Polar)), (3)正射図法(赤道)(Orthographic 
(Equatorial)), (4) 正 射 図 法 ( 南 極 )(Orthographic (South Polar)), (5) 正 射 図 法 ( 一 般 )(Orthographic 
(General)), (6)モルワイデ図法(Mollweide)。初期設定の投影法では経緯度方向が線形です。正射図法

は半球ですが、初期設定の図法とモルワイデ図法は全球です。全ての投影法において、拡大または

Map Display Options ダイアログの Domain タブを使った副領域の定義が可能です。正射図法(一般)では、

全球を表示させる任意の緯度／経度の視点(極)を指定できます。他の投影法では極緯度は固定されて

いて、極経度だけ変更できます。 

(2)から(6)の投影法では、拡大による副領域の定義が難しいので、精密な結果が必要なら Map Display 
Options ダイアログの Domain タブを使用するか、一旦、初期設定の投影法に切り替えて拡大(それから副

領域を定義)して、最後に希望する地図投影法に戻します。 

他の地図表示オプションの詳細は表示オプションの変更を参照してください。 

7.5 全画面測点図 (Full Screen Station Maps) 

背景ポップアップメニューから MAP モードを選んで、全画面の測点図を描画できます。ダブルクリックで

地図中の測点にラベル付けができ、また、削除(Del)ボタンを押して現在の測点の注釈を取り除けます。

注釈の位置は、測点の位置とダブルクリックしたときのマウスの位置との関係に依存しますので、試してみ

てください。Display Options ダイアログ・ボックスで注釈のスタイルとフォントサイズを変更できます。

File>Print を選択すると測点図のハードコピーを作成できます。またはメインメニューから File>Save As の

順に選択して地図の PostScript、PNG または JPG ファイルを作成できるので、希望するフォーマットを選ん

でください。 
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8 成分間プロット (Property-Property Plots) 

ODV が STATION モードのとき(ウィンドウの右下隅に示されます; 背景ポップアップメニューから

STATION Mode を選んで STATION モードに切り替えられます)、p キーを押すか地図上の現在の測点で

マウスの左ボタンをダブルクリックすると、現在の測点の成分間プロット(property/property plots)が作成さ

れます。他の測点のデータをプロットに追加するには、追加する測点をダブルクリックするか、または現在

の測点にしてからそれらを選択して p キーを押してください。プロットから選択されている測点の一つを削

除するには、現在の測点にして(例えば一つのプロットで、その測点の一つをクリックして)、削除(Del)キー

を押してください。画面をクリアするには Ctrl-x (コントロールキーを押しながら x)を押してください。選択し

た測点のリストをクリアするには、Ctrl-x を二回押してください。 

 

次も参照して下さい: 拡大と自動スケーリング; 新規 X、Y 変数の選択; 表示オプションの変更; 印刷; ポスト

スクリプト・ファイル。 

8.1 拡大と自動スケーリング (Zooming and Automatic Scaling) 

任意のデータプロットのウィンドウ上にマウスを移動して、右ボタンをクリックしてデータプロット・ポップアッ

プメニューを呼び出し、Full Range または Zoom のいずれかを選ぶと、変数の範囲を変えられます。Full 
Range では、現在のウィンドウの X と Y の範囲は、このウィンドウにプロットされた全てのデータに対して最

適になるように調整されます。Full Range (All)を使用すれば、画面上の全てのデータプロットを自動スケ

ーリングにできます。 

Zoom を選択すると、赤い拡大枠が現在のウィンドウの周囲に現れます。この拡大枠を操作するには、拡

大枠の上にマウスを移動して、左ボタンを押し、希望する位置に枠をドラッグしてください。現在の拡大枠

の設定を適用して、それに応じて変数の範囲の調整するには、マウスの左ボタンをダブルクリックするか
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Enter を押して下さい。拡大操作を中止して現在の変数の範囲を維持したいときは、ESC を押すかマウス

の右ボタンをクリックして下さい。 

これに加えて、最大化を制御する標準的な拡大操作である quick-zoom オプションも利用可能です。マウ

スが地図上または任意のデータプロットの上にあるとき Ctrl キーを押したままにして、マウスの左ボタンを

押したまま拡大枠をドラッグしてください。マウスの左ボタンを離すと quick-zoom で操作された拡大枠がウ

ィンドウに適用されます。 

8.2 ウィンドウ・レイアウトの変更 (Changing Window Layout) 

ODV は、モード毎(STATION, SCATTER, SECTION, SURFACE)に分けてウィンドウ・レイアウト情報を保

持します。レイアウト情報には、地図およびデータプロットの位置とサイズ、データプロットの数、X, Y, Z 軸

の変数、記号のサイズ、地図の地形ファイルの選定が含まれます。これらの各モードでは、背景ポップア

ップメニューを(背景エリア上で右マウスをクリックして)呼び出し、Graphics Layout を選択して、各々のウィ

ンドウ・レイアウトを変更できます。ODV は現在のレイアウトの輪郭を描くので、それ対してウィンドウの移

動、サイズの変更、削除、作成ができます。ウィンドウ上でこれらの操作の一つを実行するには、そのウィ

ンドウ内にマウスを動かし、右ボタンをクリックしてレイアウト・ポップアップメニュー(layout-popup menu)を
呼び出し、適切なオプションを選びます。 

Move/Resize を選択すると、赤い拡大枠が各々のウィンドウの周囲に現れます。この枠上にマウスを動かし、

左ボタンを押したままドラッグして、この拡大枠を移動させるか、大きさを変更して下さい。ウィンドウの新し

いサイズや位置を適用するには、マウスの左ボタンをダブルクリックするか、ENTER を押して下さい。

Move/Resize 操作を中止してウィンドウの状態を変更させたくない時は ESC を押します。既存のウィンドウ

をコピーして、そのプロパティを修正すると、新しいウィンドウとして使えます。重ね合わせたウィンドウ(以
下を参照)は動かしたりサイズを変えたりできません。 

既存ウィンドウの一つの上にマウスを動かして、右ボタンをクリックし Create New Window または Create 
Overlay Window オプションを選んで新しいウィンドウを作ることができます。両方の場合では、新しいウィ

ンドウの初期のプロパティは既存のウィンドウから引き継がれます。Create New Window を使うと、重ね合

わせたウィンドウが必要とするいくつかのプロパティは自動的に設定され、新しいウィンドウは既存のウィン

ドウと一列に整列させられます。Window Layout モードから抜けた後は各々のウィンドウの Display Options
ダイアログを呼び出して新しいウィンドウのプロパティを変更できます。 

ウィンドウの X, Y, Z 軸の新規変数を選択するには、適切なオプションを選択して、表示されるリスト・ボック

スの中から変数を選んでください。初期設定の変数の値は右上に増加します。方向を逆にするには(例え

ば水深図の水深)、Reverse Variable Rangeボックスをチェックして下さい。選択を適用する場合は OKを押

します。Graphics Layout モードの終了は Accept または Cancel のいずれかを選択してください。地図やデ

ータプロットのポップアップメニューから表示オプション機能を使用して、それぞれの他のプロパティを変

更できます。 

8.3 表示オプションの変更 (Changing Display Options) 

地図およびデータプロット・ポップアップメニューの Display Options 機能を使って、地図やデータプロット

の表示プロパティを変更できます。これらのメニューの呼び出しは、各々のウィンドウ上にマウスに動かし

て右ボタンをクリックします。(二つ以上のウィンドウが互いの上に積み上げられている)オーバーレイ・ウィ

ン ド ウ に 関 し て 、 こ の 方 法 は 最 上 の ウ ィ ン ド ウ だ け に ア ク セ ス し ま す 。 こ の よ う な 場 合 は

Configuration>Window Properties>…を使って個々のウィンドウのプロパティを変更してください。 
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8.3.1 地図(Map) 

“Map Display Options” プロパティ・シートは、

General, Layers, Domain, Annotations の四つの

カテゴリーに関する地図プロパティを修正しま

す。これらのカテゴリーにアクセスするには、

各々のタブをクリックしてください。 

 

 

General 

地図に使用されるカラーパレットを選択して背景カラーを選び、グリッド線を描くかどうかを指定して下さい。

地図投影法を指定し、測点を示す点の色と記号のサイズを選んで下さい。 

Layers 

ODV は、地図ウィンドウに海底地形、海岸線、陸上地形の他に、湖沼、河川、境界、流氷の張出し、海洋

フロントのような追加情報も描画できます。低解像度の全球地理情報ファイル(GlobLR シリーズ)は、

ODV(バージョン 4.1 以上)をインストールするときに初期設定で提供されます。高解像度の全球および地

域データセットはオプショナルパッケージとして利用可能で、いつでもダウンロードしてインストールできま

す。“Series” リストからインストールしたいシリーズの一つを選んでください。Bathymetry/topography カラー

バーを描きたければ Draw Color Bar ボックスをチェックして下さい。 

上述の地理情報は、ODV により個々のレイヤーとして実行されて描画されます。これらのレイヤーは、 
(1)pre-Bathymetry, (2)Ocean Bathymetry, (3) pre-Coastlines, (4)Coastlines, (5)pre-Topography, (6)Land 
Topography, (7)post-Topography.の七つのレイヤーセットにグループ化されます。Layer Sets リストで選択

して Compose ボタンを押すとレイヤーを構成できます。ODV は、このレイヤーセットを利用可能なレイヤ

ー・リストに表示します。利用可能リストから(標準的な Windows 技術を使って)一つ以上のレイヤーを選ん

で描画特性を指定し、Selected list にレイヤーを追加するには “<<”ボタンを押して下さい。Selected list か

らレイヤーを削除するには “>>”を押して下さい。 

描画特性の指定は以下の規則に従います: 

(a) (一筆書の)線で地形の輪郭が描かれる場合は、適切な線の幅、種類、色を選択します。輪郭が

不要なら色で “none”を選びます。Windows の制約のため、1 ピクセル幅以上の線は、画面上お

よび PNG と JPG ファイルでは常に一様になりますが、ODV PostScript ファイルならどのような線幅

でも、選んだ通りになります。 
(b) 地形を塗り潰したければ適切な塗り潰し色を、塗り潰したくなければ “none”を選んで下さい。 

線と塗り潰しの色を “automatic”にすると、ODV は初期設定の色を使用します。一部のレイヤーでは

“automatic”の初期値が “none”に設定されています。また、河川や境界のような一部の地形ファイルは塗
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り潰せないので、塗り潰し色は “none”と明示してください。 

ODV が地図を描画する時は、上から順にレイヤーセットが処理されます。あるレイヤーセットは、Selected 
list に表示された順で個々のレイヤーが描画されます(海底地形と陸上地形のレイヤーは、それらが追加

された時に自動的に並び替えられます)。“pre-Coastlines”設定で海氷の分布を、“post-Topography”カテ

ゴリーで湖沼、河川、境界を定義してください。 

Domain(領域) 

緯度経度の副領域を指定するか、コレクションの全領域もしくは全球地図に切り替えます。 

Annotations(注釈) 

選択された測点が航海および／または測点のラベルを持つかどうかを指定して、ラベルのフォントサイズ

を設定してください。このオプションは全画面の MAP モードと STATION モードだけに適用されます(F8 ま
たは F9を押してこれらのモードに切り替えてください)。MAPモードと STATION モードで測点を選ぶには、

マウスの左ボタンをダブルクリックしてください。測点の位置に対するマウスポインタの位置によって、ラベ

ルの位置が決まります。ラベルを測点の位置よりも上に表示させたい時は、測点より少し上を指してダブ

ルクリックして下さい; ラベルを測点の右下に表示させたい時は、右下の位置を同様にダブルクリックして

下さい。 

8.3.2 データプロット・ウィンドウ (Data-plot windows) 

成 分 間 プ ロ ッ ト (property/property plots) 
(STATION モード)では、記号のサイズとデータ

点間の結合線の幅を設定してください。記号な

し、または結合線なしの場合はゼロを選びます。
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SCATTER, SECTION, SURFACE の各モードで

は、表示モード(Original Data: カラードット、数値、

または矢印; Quick Gridding; VG Gridding)、オリジ

ナルデータのドット(またはフォント)サイズ、ポイン

ト・サイズ(SCATTER モード)、グリッド領域の X と Y
方向の平均の長さスケールを設定できます。二種

類の異なるグリッド化アルゴリズムが利用可能で、

等値線描画はどちらでもサポートされています。ま

た、X と Y の長さスケールは、各軸の範囲のパーミ

ル(1/1000)で計測され、大きな値であれば領域は

滑らかになります。様々な異なる長さスケールを試

してみて、最も好ましいものを選んでください。 

流速場の矢符プロットを作成するには Original 
Data ラジオボタンをクリックして、その真下のコンボ

ボックスから Arrows を選択します。自動的に現れ

る Arrow Properites ダイアログボックス上で矢符の

Xおよび Y成分を選択し、矢符のスケール、線幅、

色を指定してください。矢符の色を自動選択する

と、矢符に与えられる色はその場所の Z 変数に依

存します。 

軸ラベルを自動作成せずに手動で注釈を記入す

る場合は Automatic Axis Labels ボックスのチェック

を外してください。Apply to All Windows ボックスを

チェックすると、現在のモードの全データプロットに

修正が適用されます。データプロットのスタイルを

個々に設定したい場合は、このボックスのチェック

を外してください。グリ ッド領域については、

Properties ボタンを使ってオプションの追加と等値

線の指定を行ってください(以下を参照)。 
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Properties ダイアログでは以下のことができます; 

 一般オプションの追加設定 
 カラー濃淡のオン／オフの切り替え 
 範囲外の値に関する自動削除のオン／オフ

の切り替え(計算機への負荷が大きい) 
 等値線の指定 

等値線を追加するには、New グループで Start, 
Increment, End を指定します。適切な線のスタイル

と色を選んで、Label Size entry を設定し、“<<”ボタ

ンを押すと各々の等値線が追加できます。必要な

らば、異なる Start, Increment, End 値とできるだけ

異なる線のプロパティでこの操作を繰り返してくだ

さい。ウィンドウあたりの等値線の最大数は 50 本で

す。 

既存の等値線のプロパティを修正するには、

Already Defined リストでそれを選んで、New グルー

プでプロパティを修正し、“<<”を押して変更してく

ださい。 

8.4 印刷 (Printing) 

現在の ODV グラフィクス・ウィンドウの内容を印刷するには、File または背景ポップアップメニューから

Print を選択してください。 

WIN32 

ODV は Windows 標準の印刷ダイアログを呼び出しますので、システムで利用可能なプリンターを一つ選

んでください。OK を押すと印刷が始まります。複雑なグラフィクス画面の印刷にはかなりの時間を要する

傾向にあります。PostScript プリンターにアクセスできるのなら、代わりに PostScript オプションを使用してく

ださい。 

UNIX 

未だテストされていません。 

8.5 ポストスクリプト・ファイル (PostScript Files) 

全画面または個々のプロットの PostScript を作成するには、全グラフィクス・キャンバスまたは個々のプロッ

トの Save As オプションを選択してください(例えば、背景もしくは各々のプロット上でマウスを右クリックする

と Save As または Extras から Save Single As を選択できます; あるいは、背景もしくはデータプロット上で

Ctrl-s (Ctrl キーを押しながら s)を押して、ファイル形式で PostScript (*.eps)を選んでください。 

結果として得られた PostScript ファイルを PostScript プリンターに送ると印刷され、また LaTeX, Word, 
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PageMaker や他のページデザインドキュメントに読み込むこともできます(この機能を利用するには Portrait 
orientation で(印刷の向きを縦にして)プロットを保存しなければなりません)。 

Print ジョブは複雑な断面図や等値面図ではかなりの時間を要する傾向にありますが、PostScript ファイル

は中身が詰まっているので印刷は速くなります。初期設定では PostScriptファイルは ODVの一時ファイル

ディレクトリに書き込まれ、ファイル名は現在の設定ファイル名から名付けられます。その他の名前や保存

先ディレクトリは、自動的に表示される Windows ファイル保存ダイアログを使って選択できます。 

8.6 PNGとJPGファイル (PNG and JPG Files) 

背景ポップアップメニュー(ODV グラフィクス・キャンバス)から Save Canvas As, またはデータプロット・ポッ

プアップメニュー(個々のプロット)の Save Single As を選択して、現在の ODV グラフィクス画面または個々

のデータプロットを PNG または JPG ファイルへ出力できます(テキストドキュメントに含めるか、あるいは標

準的なグラフィックソフトウェアによる後処理には、PNG を使用してください)。ショートカットキーを通じてこ

れらのオプションに到達できます: (1)マウスが背景領域にあるときに Ctrl-s(Ctrl キーを押しながら s)を押す

と ODV の全グラフィクス・キャンバスのファイルが保存され、(2)データプロット上にマウスがある時に Ctrl-s
を押すと、各々のデータプロットのファイルが生成されます。ODV はファイル保存ダイアログ・ボックスを表

示するので、そこで適切な出力ファイルの形式(PNG(*.PNG)または JPG(*.JPG))を選択してください。

PNG または JPG ファイルの初期設定名は現在の設定名から名付けられますが、その他の名前または保

存先を選択することもできます。 
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9 散布図(Scatter Plots) 

9.1 散布図の作成 (Producing Scatter Plots) 

ODV の SCATTER モード (背景ポップアップメニューを使用)に切り替えて、地図上でマウスの左ボタンを

ダブルクリックすると、現在有効な全測点の成分間プロットが作成できます(オプションとして三番目の変数

を使って彩色できます)。 

 

次を参照してください: 拡大と自動スケーリング; 新規 X-Y 変数の選択; 表示オプションの変更; 印刷; ポス

トスクリプト・ファイル。 
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10 断面図 (Sections) 

10.1 断面の定義 (Defining a Section) 

断面図をプロットするには、先ず背景ポップアッ

プメニューから Section Mode オプションを使って

ODV の SECTION モードに切り替える必要があり

ます。新しい断面を定義するか、以前に定義した

断面を使うには、地図上にマウスを置いて右ボタ

ンをクリックし、地図ポップアップメニューを呼び出

してください。新しい断面の場合は Define Section
から Define Section Spine を選択し、以前に定義

した断面を使う場合には Define Section から  Load 
Sectionを選択します。後者の場合は、リストから断

面の一つを(ダブルクリックして)選ぶだけです。新

しい断面を作る時のマウス・カーソルは、ユーザ

ーが断面の中心線を定義するための連続点を入

力できる状態であることを示す細い十字記号に変

わります。細い十字記号を希望する位置に動かし

てマウスの左ボタンを押して点を入力していきま

す。点を消去するには、マウスを点の近くに動か

して右ボタンをクリックしてください。点の設定を適

用するには、ENTER を押すかマウスの左ボタン

をダブルクリックして最後の点を指定します。左図

で示されるように、任意の航跡に沿った複雑な断

面も作図できます。 

断面の中心を指定した後、ODV は断面の帯域に初期設定の幅を割り当て、初期設定の断面に沿った座

標の方向に開始点(最初に入力した点)からの距離を選びます。断面特性の初期設定を変更するために

ダイアログ・ボックスが表示されます。地図中に印された断面の帯域内にある全測点は断面に属し、後か

ら続くプロット操作でプロットされます。地図ポップアップメニューの Define Section から Change 
Characteristicsを選択すれば、いかなる時でも断面特性を変更できます。この断面を後で再利用するつも

りなら、Define Section から Save Section As オプションを選択して断面の定義を保存しなければなりません。

断面を定義しない場合は Define Section から Undefine Section を選んでください。 

10.2 断面図のプロット (Plotting a Section) 

断面の定義を一度すれば、地図上にマウスがあるときに左ボタンをダブルクリックするか p を押すと、断面

に沿ったカラーの成分分布図と断面に属する全測点の成分間プロットが描画できます。断面に沿ったカ

ラーの成分分布図の場合は、X 軸について Section Coordinate を選択し、Y 軸と Z 軸には任意の変数を

選びます。 
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次を参照してください: 拡大と自動スケーリング; カラーズーミング; カラーマッピング機能の変更; 新規 X-Y
変数の選択; 表示オプションの変更; グリッド領域の表示; プロット値の出力; 印刷; ポストスクリプト・フ

ァイル。 

10.3 カラーズーミング (Color-Zooming) 

カラー断面図と等値面上のカラー分布図は、カラーズーミングによって Z 変数の範囲を修正できます。カ

ラーズーミングを呼び出すには、修正したい断面図または等値面プロット上にマウスを動かし、右ボタンを

クリックしてデータプロット・ポップアップメニューを呼び出してください。ここで Z-Zoom を選ぶと、各ウィンド

ウのカラーバーの周りに赤い拡大枠が描かれます。前述したように、この拡大枠を操作し、ドラッグして下

さい。現在の拡大枠の設定と Z 変数の範囲の調整を適用する場合は、マウスの左ボタンをダブルクリック

するか、ENTER キーを押して下さい。拡大操作を取り止めて現在の変数の範囲を維持したい時は、ESC 
キーを押すかマウスの右ボタンをクリックして下さい。 
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10.4 カラーマッピング機能 (Color Mapping Function) 

カラー断面図と等値面上のカラー分布図に対して、Z 変数値のカラ

ーマッピングを操作できます。カラーマッピング機能を呼び出すに

は、修正したい断面図または等値面図上にマウスを動かし、右ボタ

ンクリックしてデータプロット・ポップアップメニューを表示させてくだ

さい。ここで Color Mapping を選ぶとカラーマッピングを対話的に変

更できます。カラーマッピングを非線形にするには、最高のカラー解

像度が得られる Z 値に Median トラックバーを動かし、Nonlinearity ト

ラックバーを使って非線形性を増加させてください。線形のカラーマ

ッピングへ戻すには Linear Mapping ボタンを押します。Value>color 
mapping function の変更に加えて、別のカラーパレットも読み込めま

す。 

 

10.5 グリッド領域の表示 (Displaying Gridded Fields) 

サンプルの位置にカラーの点を表示する代わりに、二つのグリッド化アルゴリズム: Quick Gridding と VG 
Gridding のいずれかを使用して、Z 変数を持つ任意のウィンドウに対してグリッド化した成分の領域を作

成できます(例えば、断面に沿った、あるいは等値面上の成分分布図)。Quick Gridding は良好なデータ・

カバレッジであれば良い結果を素早く生成できる方法ですが、不十分で不均質なデータ・カバレッジであ

れば VG Gridding の方が適しています(下記参照)。カラー濃淡に加えて、成分領域での等値線描画は両

方のグリッド化モードでサポートされています。 

「オリジナルのデータ点」モードからグリッド化モードの一つに切り替えるには、修正したいデータプロット

上にマウスを移動させて右ボタンをクリックし、データプロット・ポップアップメニューを呼び出します。ここで

Display Options を選択して Quick Gridding または VG Gridding のどちらかのボタンをチェックしてから X
軸および Y 軸のそれぞれに適切な平均の長さスケールを設定します。値は、軸の全範囲のパーミル

(1/1000)で表され、値が大きければ平滑化された領域になります。Properties ボタンを押せば、成分領域

に対する等値線の定義や他の成分を設定できます。個々のプロットの表示オプションを修正したい場合

は、Apply to All Windows ボックスがチェックされていないことを確認して下さい。ODV の出力に不満があ

れば、断面図または等値面図のデータを出力して、専用のグリッド化および等値線描画ソフトウェアの使

用を検討して下さい。 

10.5.1    VGグリッド化アルゴリズム (VG Gridding Algorithm) 

等距離で矩形のグリッドに使われる Quick Gridding とは対照的に、 VG Gridding はデータ点の分布を解

析して、データ密度にしたがってX軸およびY軸のグリッド間隔が変化する領域では、可変な解像度で矩

形のグリッドを構築します。良好なデータ・カバレッジでは高解像度(狭いグリッド間隔)となりますが、サン

プルが乏しい領域では、グリッドは粗く解像度は制限されます。例えば典型的な海洋観測の断面に対し

てこの方法を用いると、外洋域の深層に比べて(データ・カバレッジが通常は良好な)上層の水柱および

境界流域では高空間分解能となります。 

グリッドの構築後、検討中の成分(水温や塩分など)は、グリッド・ポイントの近傍のデータ値を使用した加



Ocean Data View ユーザーズガイド –  2003/02/10 – 2003/03/03[JP] 
 

 45

重平均法が適用されて全てのグリッド・ポイントで評価されます。重みはグリッド・ポイントからの距離に比

例して減少し、ユーザーが指定した X、Y 方向の長さスケール(e-folding)で分けられます。ユーザーが指

定する X、Y の長さスケールは、各軸の範囲の「パーミル」(1/1000)で計られ、最も乏しいデータ・カバレッ

ジ(最も粗いグリッド)の領域で代表されます。平均の長さスケールはグリッドの間隔に比例します; 例えば、

高解像度のグリッド領域(上層の水柱や境界流など)では、短い平均の長さスケールが自動的に使用され

ます。この総合的な取り組みによって、高密度なデータ範囲における微小スケール構造の特性が解明さ

れ、同時に、観測が乏しい海域でも滑らかで安定した領域が得られます。数千ものデータがあっても数秒

以内に領域を評価できるように実行速度を上げる特別な方法が実装されています。 

最終段階で、評価された領域の値は濃淡と等値線の描画処理に渡され、画面やプリンターに結果が出

力されます。 

10.6 差分領域 (Difference Fields) 

以前に保存した基準データと現在選択している測点の成分分布を比較することができ、成分間の差分を

導変数として定義して別の領域を生成できます。ODV の背景メニュー(または Alt+d(Alt キーを押しながら

d キー)を押します)から Derived Variables を選択して、Diff. from Ref を選んでください。Temp\Reference
サブディレクトリから使用したい基準データの ExportID.txt ファイルを選ぶと、ODV はそのディレクトリから

利用可能な基準データファイルのリストを表示します。 

Z 変数として差分領域を生成する変数と、適切な X および Y 変数(例えば、緯度と水深の断面を生成する

には、基準データファイルの X が緯度、Y が深さであることを確認してください)を持つ.oal ファイルを選ん

でください。次に、現在のコレクションの Z, X, Y の各変数を指定して(経度または緯度が必要ならば、Diff. 
from Ref.を呼び出す前に導変数として定義してください)、差分変数の定義を完了してください。新しい変

数の名前は、Z 変数の名前と基準データセットの識別文字列(identification string)で構成されています。

一度定義すれば、どのデータプロットでも差分変数を使用できます。 
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11 等値面 (Iso-Surfaces) 

11.1 等値面の定義 (Defining Iso-Surfaces) 

SURFACEモード(背景ポップアップメニューからSURFACE Modeを選択)に切り替えるか、背景ポップアッ

プメニューから Iso-Surface Variables を選択すると、ODV は現在定義されている等値面の変数のリストを

表示するので、新規または既存の等値面変数の編集と削除を行ってください。既存の等値面の変数を削

除するには、変数をマウスの左ボタンでダブルクリックをするか、マウスの左ボタンをクリックして変数を選

んでから Deleteを押します。新しい等値面の変数を追加するには、まず Newボックスの中で変数を構成し

てから Addを押して下さい。等値面の変数を構成するには、ある表面に表示したい変数(表示変数)、表面

を定義する変数(等値面変数)、そして等値面変数の数値を指定する必要があります。上部または下部の

成分分布には、等値面変数として Depthを選択し、数値の代わりに topまたは bottomと入力して下さい(最
初の文字の t または b で十分です)。表示変数または等値面変数に導変数を使いたければ、Iso-Surface 
Variable ダイアログを呼び出す前に定義済み(導数量(Derived Quantities)参照)であることを確認して下さ

い。 

 

Already Defined ボックスで等値面変数を選んだら、S-Sync ボタン(等値面との同期)をクリックして同じ等値

面を使う他の全ての変数と同期します。V-Sync ボタン(変数との同期)をクリックすると同じ表示変数を使う

他の全ての変数と同期できます。 

11.2 等値面分布のプロット (Plotting Surface Distributions) 

等値面変数を一度定義すると、マウスが地図上にあるときに左ボタンをダブルクリックするか p を押して、

地図上に印される全測点を使った等値面成分間プロットと同様に、等値面上のカラー成分分布図を描画

できます。カラープロットでは X, Y 軸に対して経度、緯度がそれぞれ与えられます。他の全ての集まりで

は、成分間プロットが得られます。定義を明示した等値面変数に加えて、時間、年内日、経度、緯度のよう

な追加パラメータは全ての測点に対して記録されていて、成分間プロットで使用できます。 
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次を参照してください: 拡大と自動スケーリング; カラーズーミング; カラーマッピング機能の変更; 新規 X-Y
変数の選択; 表示オプションの変更; グリッド領域の表示; プロット値の出力; 印刷; ポストスクリプト・フ

ァイル。 
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12 NetCDF対応 (NetCDF Support) 

12.1 NetCDFの概要 (NetCDF Overview) 

NetCDF (network Common Data Form)は配列指向のデータ保管およびアクセスのためのインターフェイ

スで、気候研究やその他の地球科学の分野で広く用いられています。多くの重要なデータセットやモデ

ルの出力ファイルが netCDF フォーマットによって研究者間で配布され共有されています。 

12.1.1 NetCDFとは (NetCDF data is) 

 自己記述方式です。netCDF ファイルは包含データの関する情報を含んでいます。 
 アーキテクチャに依存しません。 netCDF ファイルは、整数、文字列、浮動小数点の記憶方式が

異なるコンピュータでもアクセスできる形式で表されています。 
 ダイレクト・アクセスが可能です。最初に全てのデータを読み取らなくても、大きなデータセットの

一部分に効率よくアクセスできます。 
 追加が容易です(Appendable)。データセットをコピーまたはその構造を再定義しなくても、デー

タを一次元で netCDF データセットに追加できます。時々データセットがコピーされることになりま

すが、netCDF データセットの構造は変更可能です。 
 共有性(Sharable)があります。同じ netCDF ファイルに対して同時に、一人のユーザーが書き込

んで複数のユーザーが読み取れます。  

12.1.2 NetCDF協定 (NetCDF conventions) 

NetCDFデータモデルは非常に一般的で、netCDFの構造や内容を大幅に変えられます。NetCDFデータ

セットの相互交換および共有を容易にして促進するために、いくつかの協定が決められています。これら

の協定のうち二つ(COARDS および GDT; 仕様は 
http://www.unidata.ucar.edu/packages/netcdf/conventions.html 

を参照 )は、気候研究者やモデル研究者が広く使っており、非常に多くの重要なデータセットが

COARDS/GDT netCDF ファイルとして利用可能です。このようなデータセットは、例えば次のサイトからダ

ウンロードが可能です: 

http://www.cdc.noaa.gov/PublicData/, http://ferret.wrc.noaa.gov/, http://ingrid.ldeo.columbia.edu/, 
http://www.epic.noaa.gov/epic/ewb/. 

より詳細な netCDF の情報は、netCDF web ページをご覧ください: 

http://www.unidata.ucar.edu/packages/netcdf/. 

12.1.3 ODV のnetCDF対応 (ODV netCDF support) 

ODV は ODV コレクションと同様に netCDF ファイルのデータを読み込んで可視化します。NetCDF ファイ

ルで作業しているときも ODVの全機能が利用可能です。ただし、netCDFファイルへの書き込み許可が必

要なときと、データセットを修正するときは例外です(ODVは netCDFファイルに書き込むことができません)。
NetCDF ファイルが COARDS と GDT の netCDF 慣例に従っていれば、ODV は多くの変数を解釈すること

ができます。例えば、絶対的または相対的な時間のフォーマット、欠測値の指示子のような変数の属性の

識別、長い変数名、単位などです。ODV は、非常に大きなデータセットで作業している時にしばしば必要

となるデータの副設定が可能です。 
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12.2 NetCDFファイルの使用 (Using netCDF Files) 

ODV は、地球科学の様々な分野の研究者によって広く使われている netCDF ファイルのデータの読み取

りと可視化ができます。ユーザーによるわずかな設定や選択に基づいて、ODV は本来の ODV コレクショ

ンをエミュレート(模倣)する方法で、netCDF ファイルにアクセスして解釈します。ODV の解析および可視

化の全機能が netCDF ファイルのデータの調査に利用できます。最初にデータを変換してから再度読み

込む必要はありません。NetCDF ファイルの構造または内容によっては、別々の ODV エミュレーションが

可能です。個々のエミュレーションの設定は、後で使用できるようにディスク上に保存することができます。

NetCDF ファイルはプラットフォーム(訳注: コンピュータの種類)に依存しないので、同じファイルを

Windows または Solaris 上の ODV で使用できます。 

(1) netCDF ファイルを開く(Opening a netCDF file) 

File>Open netCDF File の順に選択すると、ODV で netCDF ファイルを開くことができます。標準の

Windows ファイル選択ダイアログを使って、開きたいファイルを指定してください。または、コマンド行の引

数に netCDF ファイル名を指定して、コマンド行から ODV を起動できます。Windows なら、ODV デスクトッ

プ・アイコンに netCDF ファイルをドラッグすることもできます。いずれの場合も、netCDF ファイルの拡張子

は.nc または.cdf でなければなりません。ODV は netCDF ファイルを開いて、ファイルに含まれている次元

や変数に関する情報を検索します。 

(2) netCDF エミュレーションの定義 (Defining the netCDF emulation) 

一連のステップにおいて、ODVがどのようにして netCDFファイルを閲覧(またはエミュレート)するのかを定

義する必要があります。これには、座標軸(次元)の選択と(もし必要なら)副設定、netCDF ファイルからの

情報に基づく ODV ヘッダー変数との関連付け、「測点」(例えばプロファイルや連続観測など)の論理的な

構造を決めて測点内で並び替えるための一番目の変数(ODV コレクションの第一変数)の定義が含まれ

ます。 

最初に ODV は、新しくエミュレーションを定義するか、または既に定義されて保存されているエミュレーシ

ョンを使うのかを尋ねてきます。既に定義されたエミュレーションを選ぶと追加入力の必要はなく、ODV は

本来の ODV コレクションと同様に処理します: 測点図が描画され、ODV の解析および可視化に関する全

機能が利用できます。ODV は開いた netCDF ファイルを読み取り専用のデータセットとして扱うので、修正

ができません。したがって、データを書き込む操作が求められる全ての機能(データの読み込み、ヘッダ

ーおよびデータの編集、コレクションの取り扱い操作など)は、netCDF ファイルでの作業中は利用できま

せん。 

(2.a) netCDF 座標の副設定および選択 (Subsetting and selecting netCDF coordinates) 

新しくエミュレーションを定義する時に最初に行う作業は、netCDFの座標の副設定と選択です。ODVは、

ファイルに含まれている次元／座標のリストを、それらの長さと現在使用されているインデックスとともに表

示します(Dimensions リストに表示されます; インデックスは 0から始まり、インデックス・セットは「開始インデ

ックス: 間隔(stride): 終了インデックス」で定義されます; 初期のインデックスは全てインデックスです)。 
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副設定 (Subsetting) 

非常に大きい netCDF ファイルの場合は特に、興味のある範囲にアクセスするデータの制限、または

解析から他のデータを除外する必要がしばしばあります。例えば、何ヵ月ものデータを含んでいるファ

イルの中で、数ヵ月または一月分だけに興味がある場合は、時間軸の副設定が必要となります。多く

の観測層を含んでいるファイルの中から、ある特定の水深だけを解析したいような場合は、解析を行

う前に深さの次元を設定してください。 

特に次元／座標を設定する場合には、Dimensions リストの中から項目を選んで、Subset Dimension ボ
タンを押してください(このボタンを有効にするには、次元がリストの中で唯一の選択でなければなりま

せん)。ODV は全ての座標値のリストを表示しますので、使用するインデックス・セットの start index, 
stride(間隔)、end index を指定してください。単独のインデックスを選ぶには、start index および end 
index のフィールドと同じインデックス値を入力します。この新しいインデックスを適用するには OK を
押して下さい。設定したい全ての次元／座標に対してこの手順を繰り返してください。 

選択 (Selection) 

次に、この後の関連付けられた変数の解析に使いたい全ての次元／座標を選択しなければなりませ

ん。拡張選択技術(Ctrl または Shift キーを押したままマウスの左ボタンをクリックする)を使って複数選

択を行ってください。多次元で共通の座標である X(経度)、Y(緯度)、Z(水深／高度)、T(時間)を使う

場合は、各方向につき一つだけ選択して下さい。 

ある次元を選択すると、これらの次元上で定義されている netCDF 変数セットが Corresponding 
Variables リストに表示されます。興味のある変数がこのリストに表示されているかどうか確認して下さ

い。Dimension リストで選択されなかった座標に依存する netCDF ファイルの他の変数は、

Corresponding Variables には表示されず、対応する次元を選ばない限り、それらの変数は利用でき

ません。NetCDF ファイルの完全なヘッダー情報を閲覧するには(“ncdump -h”に相当)、netCDF Info
を押してください。 

(2.b) ヘッダー情報の明示 (Specifying header information) 

次に、ODV 測点にヘッダー(またはメタ)情報を与える netCDF 変数を特定しなければなりません: 例えば、

経度(Lon(°E))、緯度(Lat(°N))、日付(mon/day/yr)など。これは、netCDF ファイルの変数(Source Variables
リスト)と標準 ODV ヘッダー変数(Target Variables リスト)と間で関連付けによって行われます。最初に

ODV は自動的に変数の識別と関連付けを試みます。手動による変数の関連付けは、一桁目のカラムに*
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が付いていないヘッダー変数に関してだけ必要となります。通常は経度(Lon(°E))、緯度(Lat(°N))、日付

(mon/day/yr)の関連付けだけで十分です。どのnetCDF変数にも関連付けられないヘッダー変数に対して

は初期設定の値が使われます。ヘッダー変数の初期値(例えば航海名など)を修正するには、Target 
Variables の中からそれを選び、 Set Default を押してください。 

NetCDF 変数と ODV ヘッダー変数との間で(一対一)の関連付けを行うには、Source Variables リストの中

から netCDF 変数を、Target Variable リストの中からヘッダー変数を選んで Associate を押してください。

NetCDF と ODV ヘッダー変数との間で変換を行うには(通常は netCDF の時間変数に必要)、上述した二

つの変数を選んでから Convert を押します。コンボボックスから利用可能な変換オプションを一つ選んで、

OK を押してください。 General Linear Transformation にはスケール係数とオフセットを与えます。 

 

多くの netCDF ファイルでは、特定の開始日付からの日数や時間といった相対的な時間を使用します。測

点の日付と時刻を得るにはこの情報が利用できます。そうするには、Source Variables リストから相対時間

を、Target Variables から日付(mon/day/yr)を選んでから、Convert を押してください。ODV は自動的に変

換関数の確立を試みますが、手動で適切な変換アルゴリズムも選択できます。ODV は基準日付がグレゴ

リオ暦に基づいていると仮定します。ODV の日付(mon/day/yr)の値は、グレゴリオ暦の日付です。 

ヘッダー変数の Station と Type は自動的に ODV で設定されます。 

(2.c) 基本座標の選択 (Selecting primary coordinate) 

最後に、コレクションの第一変数として後で ODV が使用する基本座標を選択する必要があります。この変

数は station/profile/sequence の変数の並び替えにも使われます。ODV が測点として取り扱う論理構造を

確定するので、基本座標の明示は重要です。例えば、基本座標として「水深」または他の鉛直座標を使

用すれば、測点は鉛直プロファイルを表します; 時間を使用すれば、測点は時系列で表されます。日付

(mon/day/yr)ヘッダー変数が上記(2.b)で定義されていれば、Use Decimal Date/Time の項目が使用可能

になり、基本座標として測点ヘッダーから導かれる十進数の時間変数(単位＝年)が使用できます(時系列

に関しては、日付(mon/day/yr)ヘッダー情報は時系列の開始を定数として参照します)。 



Ocean Data View ユーザーズガイド –  2003/02/10 – 2003/03/03[JP] 
 

 52

 

NetCDF ファイルのデータが水平面上の値(例とえば、大気－海洋境界面を横切るフラックスなど)を表し

ているが、各々の表面を明らかに特定する netCDF 変数がない(例えば、鉛直座標がない))場合は、Use 
Dummy Variable項目を選択して、ダミー変数のラベルと単位(例えば Depth [m])、および表面の定義に関

連付けられた数値(例えば海面には 0)を指定します。 

(3) netCDF ファイルの探究 (Exploring the netCDF file) 

一度(2.a)から(2.c)までのステップが完了すると、ODV は netCDF ファイルからデータを読み始めます。

ODV は測点図を描き、ODV の解析および可視化の全機能分析・表示機能を使用できます。ODV は

netCDF ファイルには書き込まずに読み込み専用のデータセットとして扱います。したがって、データを書

き込む操作が求められる全ての機能(データの読み込み、ヘッダーおよびデータの編集、コレクションの

取り扱い操作など)は、netCDF ファイルでの作業中は利用できません。 

また、netCDF ファイルからのデータアクセスは、本来の ODV コレクションに比べると遅くなります。何万も

の(エミュレートされた)測点を含む大きな netCDF データセットを使って SCATTER(散布図)または

SURFACE(等値面図)の作成が遅く感じる場合は、(上述の)次元の副設定を検討するか、Export の ODV 
Collection を使って本来の ODV コレクションに netCDF データを出力してから解析と可視化にこの新規作

成したコレクションを使用してください。 

鉛直断面図を作成するには、SECTION モードに切り替えてください。例えば Configuration>Use 
Template>SECTION 2 Win の順に選択してから、地図ポップアップメニューの Define Section>Define 
Section Spine を使用して選択する断面を定義します。水平面上あるいは他の緯度／経度の等値面上の

成分分布を描画するには、例えば Configuration>Use Template>SURFACE 1 Win の順に選んで

SURFACE モードに切り替えてください。それから Configuration>Iso-Surface Variables によって等値面変

数を定義し、プロット・ウィンドウ上の Z 変数としてそれらを使用します。 

現在の設定を保存するとき、上述の(2.a)から(2.c)までのステップで指定した netCDF エミュレーションの設

定は、後で利用するために.nce ファイルに保存されます。 
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13 コレクションの操作 (Manipulating Collections) 

13.1 コレクション変数セットの変更(Changing the Set of Collection Variables) 

新しいデータが、与えられたデータコレクションに未だ含まれていない変数によって利用可能になる時に

は、これらの変数をコレクションに追加しなければなりません。また、時にはいくつかの既存の変数をコレク

ションから削除しなければならないでしょう。 

コレクション変数を追加および／または削除するに

は、コレクションを開いて、メインメニューから 
Collection>Add/Delete Variables の順に選択してく

ださい。新しい変数を追加するには、(括弧[]で括

る単位も含めて)変数ラベルを New Variable コント

ロールに入力してから Add を押します。変数を削

除するには、Defined Variables リストから変数を選

択して、Delete を押してください。変数の並びを変

更するには、変数を一つ選んで Up または Down
で動かします。実行する場合は OK を押して下さ

い。全コレクションは書き直されなければならず、

大きなデータコレクションであればある程度の時間

がかかります。 
 

13.2 並べ替えと圧縮 (Sorting and Condensing) 

ODV の測点検索および選択アルゴリズムは、コレクション内の測点がある特定の方法で並び替えられて

いる時に最も効率よく機能します。したがって、多くの測点の読み込み、入れ替え、結合、削除の後には、

コレクションを並べ替えて圧縮することを推奨します。並べ替えと圧縮処理の呼び出すには、ODV のメイ

ンメニューから Collection>Sort and Condense の順に選択します。 

13.3 選択済み測点サブセットの削除(Deleting Selected Station-Subset) 

ODV のメインメニューから Collection>Delete Station Subset の順に選択すると、現在選択されている測点

をコレクションから削除できます。現在の測点だけの削除であれば、Collection>Delete Current Station を

選んで下さい。コレクションのディスク・ファイル中の削除された測点のデータ空間は、コレクションの並べ

替えと圧縮を行わない限り解放されません。 
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14 ユーティリティ (Utilities) 

14.1 データインベントリ・テーブル (Data Inventory Tables) 

ODV のメインメニューから Utilities>Inventory Table from の順に選ぶと、現在開いているコレクションのイ

ンベントリ・テーブルを作成できます。出力ファイルは単純なアスキーファイルで、コレクションのディレクト

リに書き出されます(拡張子は.inv)。 

14.2 時系列データ分布図 (Temporal Data Distribution Plots) 

ODV のメインメニューから Utilities>Temporal Distribution の順に選ぶと、現在選択されている測点の(月
および年の)時系列分布図を描画できます。 

 

14.3 データ検索 (Data Retrieval) 

ODV は、経度/緯度/水深(Lon/Lat/Depth)の間隔で定義された範囲における全てのオリジナルデータ点を

使って、選んだ変数の平均値および標準偏差を計算して出力することができます。現在の選択基準を満
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たして、地図上に表示されている測点だけが検索の対象となります。検索の呼び出しに先立って適切な

測点選択基準を適用すると、異なる年、月、季節毎の平均値が得られます。データ検索オプションを選ぶ

には、ODVのメインメニューから Utilities>Data Retrievalの順に選ぶと、データ検索オプションを選択でき

ます。ODV は、検索ボックスのジオメトリ情報を含む検索入力ファイル(拡張子.rtv)と、出力する変数の数

を促します。“.rtv”ファイルは検索オプションの呼び出しに先立って用意されていなければなりません。 

“.rtv” ファイルのフォーマットは次の通りです: 

 単純なアスキーファイルで、一行につき一つのボックス／変数が定義され、(一つ以上の)スペー

スで区切られる七つの数字で、 
 数字の意味は: 経度 緯度 水深 (ボックス中央の)経度 緯度 水深 変数の数。 

一度.rtvファイルを指定したら、ODVは作業を開始します。平均する際に、ODVは範囲外のデータをチェ

ックし、平均値から標準偏差の三倍以内のデータだけを使います。出力は.rtv ファイルと同じ名前で拡張

子が.out のファイルに書き出されます。 

出力ファイル.out のフォーマットは次の通りです: 

 単純なアスキーファイルで、.rtv ファイル中の一行につき一行の出力ライン、タブ区切りの 11 個

の値、 
 値の意味: lon lat dep variable# (.rtv ファイルと同じ)alon alat adep aval+-sdev nu nr. 

alon, alat, adep, ava はそれぞれ平均の経度、緯度、水深、使用されたデータの変数値を、sdev は個々の

変数値の標準偏差を表します。nu は使用されたデータ点の数、nr は除外したデータ点の数です。各々の

検索ボックスについて、全ての個々のデータ値は、ODV の一時ファイルディレクトリ(通常は c:\Program 
Files\Ocean Data View (mp)\Temp)のアスキーファイル ODVrtv?.dat に出力されます。“.dat”ファイル中の

値の意味は次の通りです: 番号 経度 緯度 水深 年内の経過日値 重み 使用／除外フラグ。 

14.4 地衡流 (Geostrophic Flows) 

SECTION モードで、ODV は Utilities>Geostrophic Flows オプションで地衡流速を計算して可視化します。

水深面あるいは他の基本または導変数(例えば、ポテンシャル密度など)の等値面を選択して基準層を定

義し、結果を受け取る.o4x 出力ファイルの名前を指定してください。初期設定では、このファイルはコレク

ションのディレクトリの‘GeoVel’サブディレクトリ (このサブディレクトリがなければ自動的に作成されます)に
書き出されます。ODV が計算を始めると、上記で指定した.o4x ファイルにペアとなる測点の結果と地衡流

速を出力します。 

一旦完了したら、新規に計算したペアの断面と速度データに関する新しい ODV セッションの呼び出しが

可能になります。‘Yes’をクリックすると、新しい ODV セッションは GeoVel ディレクトリに新しいコレクション

を作成し、書き出されたばかりの.o4x ファイルを自動的に読み込みます。それから標準的な ODV の手順

に従って、地図を拡大して適切な地図領域を定義し、F11 キーを押して SECTION モードに切り替えて、

一つ以上のプロット・ウィンドウの Z 変数として Geostr. Vel. [cm/s], Geostr. Vel. (north comp.) [cm/s], Geostr. 
Vel. (east comp.) [cm/s]を定義してください。与えられた測点のペアの測点ラベル A->B: alpha は、ペアに

用いた測点のオリジナル測点番号 Aと B、Geostr. Vel. [cm/s] の正の値を持つ流れの方角 alpha (alpha=0: 
東向き; alpha=90: 北向き; など) で構成されています。 

地衡流速は、二点の海洋観測間における力学的高度の差から計算されます。一般的に、二つの測点の

観測深度は一致しないので、最初のステップで、観測値を共通の深度に配置し直します(ODV は定義済

みの標準層へ内挿するために、区間線形の最小自乗法を使います)。それから、標準層での力学的高度
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が両測点で計算され、力学的高度の差から(標準層における)測点間の地衡流速が得られます。ODV は

コレクションの全変数の平均値(二点間の平均)も計算します。二点平均と地衡流速の両者は、二測点間

の中間の値を表しており、ODV はペアである二測点間の中間点における「仮想」ペア測点としてこれらの

値を.o4x 出力ファイルに書き出します(ペア測点の測点ラベルはオリジナル測点の測点ラベルを含んでい

ます)。 

赤道の近く、または粗い海洋観測の測点について地衡流速は計算されません。結果はデータエラーに

非常に敏感ですので、Utilities>Geostrophic Flows オプションの呼び出しに先立って、断面の水温および

塩分データの品質管理を慎重に行って下さい。処理方法の一つは、データ編集を使って “Questionable”
または “Bad”のような疑わしいデータにフラグを付加して、(適切な選択基準を適用した) “Good”データだ

けを表示と計算に使うことです。適切な測点選択基準を適用することで、ある調査に関する測点だけが計

算に含まれていないか、または断面帯の内部にある他の航海の測点が除外されているか確認できます

(断面帯を横切る他の海洋観測線に注意してください)。 

14.5 基準データセット (Reference Datasets) 

現在のプロット・ウィンドウのオリジナルデータをアスキーファイルに保存して、メインメニューから 
Utilities>Define as Reference の順に選択して、これらのデータを基準データセットとして後で使用できま

す。基準データ(txtID)を識別する説明文を入力して OK をクリックしてください。ODV は Reference\txtID と

いう名前のサブディレクトリを ODV のローカル・ディレクトリ(通常<home>\odv_local)に作成して、このディ

レクトリに全てのファイルを書き出します。すでに存在していれば、ODV は作業を継続する前にこのディレ

クトリから全ファイルを削除するための許可を問い合わせてきます。基準データは、差分変数を定義すると

きに ODV が使用します。 

14.6 範囲外の値の検索 (Finding Outliers) 

Utilities>Find Outliers オプションを選択すると、指定された範囲外のデータ値を持つサンプルを現在選

択されている測点から走査できます。変数リストから走査する変数を選び、範囲の最小値および最大値を

入力してください。 OK を押すと走査が始まります。ODV は見つかった範囲外の値の数を知らせてきます

ので、範囲外の値のリストを見て、範囲外のデータ値または品質フラグを検査したり修正したりしてくださ

い。 

Inspect and Edit Outliers をチェックすると、ODV は認識した全ての範囲外の値を見て回り、各々の値を削

除するか、 “Questionable”または “Bad”として印をつけるかどうか問い合わせてきます。Apply to Allを押す

と ODV は選択された全ての範囲外の値に適用しますが、そうでなければユーザーは個々の範囲外の値

に対する操作を促されます。各々の範囲外の値はデータプロット中で印が付けられます。 

14.7 重複測点の検出 (Finding Redundant Stations) 

Utilities>Find Redundant Stations を選択すると、占有地内で同一または近傍の位置と時間を持つ測点

(重複測点)をコレクションから走査できます。重複測点のリストはディスクに書き出されます(初期設定名は

redundant.lst)。“redundant.lst”ファイルでは、重複測点のセットが空白行で区切られています。各測点に

は次の情報が与えられます: (1) internal no.(内部番号), (2) cruise label (航海ラベル), (3) station label (測
点ラベル), (4) station type (測点の型), (5) date (日付)、(6) longitude (経度), (7) latitude (緯度), (8) no. of 
observed levels (観測層数), (9) deepest level (最深観測層), (10)基本変数 2～nvar の有効率を示す指示

子(例えば 7 は、ある変数に関して 70 から 79％までの観測層のデータが含まれていることを意味します)。
重複測点を削除するには、地図ポップアップメニューの Select Station by Name を使って現在の測点にし

てから、Actions>Delete Current Station を使って削除します。 
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大きなコレクションでは、重複測点の走査にかなりの時間を要します。 
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15 グラフィクス・オブジェクト (Graphics Objects) 

ODV のグラフィクス出力を改良できます; テキストを追加したり、データ点を強調したり、線や他の幾何学

的なオブジェクトを追加して、専門的な仕上がりが得られます。ODV のグラフィクス・オブジェクトは(1)注
釈(text annotations)、(2)直線(straight lines)、(3)四角形(rectangles and squares)、(4)楕円および円(ellipses 
and circles)、(5)結合線(polylines)(直線のセグメントもしくはベジエ曲線(straight-line segments or Bezier 
smoothed))、(6)塗り潰し多角形(filled polygons)(直線のセグメントもしくはベジエ曲線)、(7)シンボル

(symbols)、(8) シンボルセット(symbol sets)、(9)凡例(legends)を含んでいます。 

作成(Creation) 

自動的に作成される凡例を除いて、地図またはデータプロット・ポップアップメニューから Extras>Add 
Graphics Object>... (ここで...は、作りたいオブジェクトの種類を表す)の順に選択するか、あるいは背景ポ

ップアップメニューから Add Graphics Object>...の順に選択して、その他のグラフィックス・オブジェクトを作

成して追加できます。作成後には、オブジェクトの様々なプロパティを定義するためのダイアログ・ボックス

が表示されます。これらのプロパティはいつでも変更が可能です(下記の編集と削除(Edit and Delete)を参

照してください)。グラフィクス・オブジェクトは、作成を始めたときのウィンドウ(または背景領域)の所有とな

り、グラフィクス・オブジェクトの座標は、各ウィンドウの座標系に記録されます。その結果、各ウィンドウを

移動したりサイズを変更したりすると、ウィンドウの全てのオブジェクトも自動的に追従します。 

編集と削除(Edit and Delete) 

オブジェクト(シンボルセットの場合はどれか一つ)の上にマウス動かして右ボタンをクリックし、ポップアップ

メニューから Edit Object を選んで、そのオブジェクトのプロパティを修正できます。ダイアログ・ボックス(別
のオブジェクトには別の)が現れますので、簡単かつ素早くプロパティを変更できます。いかなるグラフィク

ス・オブジェクトも、その親ウィンドウに切り抜かれるので(clip to window ボックスをチェック)、ウィンドウにデ

ータが描かれる前にそれを描くようにもできます(pre-data plot ボックスをチェック)。マウスをオブジェクト上

に動かしてマウスの右ボタンをクリックし、Delete Object を選択して、そのオブジェクトを削除できます。 

ドラッグ(Dragging) 

グラフィクス・オブジェクトの属性 allow dragging が設定されていると、異なる位置にドラッグするだけでそ

のオブジェクトを再配置できます。オブジェクトをドラッグするには、そのオブジェクト上にマウスを動かし、

左ボタンを押したままマウスを動かして下さい。初期設定では、データ値にリンクされたシンボルセットを除

いた他の全てのグラフィクス・オブジェクトに対して、ドラッグが有効になっています。“allow dragging”属性

は、Edit ダイアログ(上記参照)を使っていつでも変更できます。 

15.1 注釈 (Annotations) 

ODV のグラフィクス・ウィンドウに注釈を追加するには、背景、地図、またはデータプロット・ポップアップメ

ニューから(Extras>)Add Graphics Object>Annotation の順に選択してください。細い十字記号のカーソル

が現れますので、注釈を表示したい位置にそれを動かして、マウスの左ボタンをクリックします。個々のオ

ブジェクトは、作成を始めたときのウィンドウの所有になります。注釈を追加(または編集)する際に、注釈文

の位置、方向(度、反時計回り)、フォントサイズ(ポイント)、色、配置パラメータを設定してください。注釈は

枠を持つことができ、注釈を描く前に注釈の矩形枠を塗り潰せます。これらの全項目に対して別々の色を

選べます。注釈文の最大の文字数は 255 文字です。特殊文字の効果として、文中に次の制御文字列が

使えます: 

~$ 記号フォント(ギリシャ文字)へ切り替える 
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~# 通常のテキスト・フォントへ切り替える 
~% パーミル記号を生成する 
~^ 次の文字を上付きにする 
~_ 次の文字を下付きにする 

他の全てのグラフィクス・オブジェクトと同様に、マウス・カーソルを注釈の上に移動させて、マウスの左ボ

タンを押しながら動かすと、注釈を別の場所にドラッグできます。マウスを注釈の上に移動させて、マウス

の右ボタンをクリックして、ポップアップメニューから Edit Object を選択すると注釈を編集できます。注釈

(全注釈)を削除するには、ポップアップメニューから Delete Object(Delete All Objects)を選択してください。 

データプロット・ウィンドウの軸ラベルは(自動)注釈として実装されています。それらはプロット・ウィンドウが

描かれると自動的に作成され、各データプロット・ウィンドウが削除されると削除されます。軸ラベルをドラッ

グ、編集、削除することはできますが、プロット・ウィンドウが再描画されると自動作成版が再表示されてし

まいます。軸ラベルを「永久に(permanently)」に変更したい場合は、背景ポップアップメニューから

Extras>Add Graphics Object>Annotationの順に選択して、手動で注釈を作成してください。新しい注釈を

定義した後で設定の保存を確認し、印刷または PostScript ファイルに書き出す前に自動作成された軸の

注釈を削除して下さい。 

15.2 線および多角形 (Lines and Polygons) 

地図、データプロット、または背景に直線(straight lines)、結合線(polylines)、または多角形(polygons)を追

加 す る に は 、 デ ー タ プ ロ ッ ト ま た は 背 景 ポ ッ プ ア ッ プ メ ニ ュ ー の (Extras>)Add Graphics 
Object>Line>Polyline または Polygon を選択してください。三つのケースともにカーソルが細い十字記号

に変わりますので、オブジェクトの節点を指定してください。「直線」では始点と終点を定義しなければなり

ません: 十字記号を直線の始点に動かしてマウスの左ボタンをクリックし、それから終点に動かして、再度

左ボタンをクリックして下さい。結合線または多角形では、最大 1000 点まで定義できます。多角形は ODV
によって自動的に閉じられます。節点を削除するときには、十字記号をその近くに移動させてからマウス

の右ボタンをクリックします。ENTER を押すと、多角形または結合線の点の定義が終わります。 

直線、結合線または多角形の節点を一度指定すると、ODV は(結合)線の色、幅と種類、多角形の塗り潰

し色(直線と結合線では無視されます; 多角形の塗り潰しを避けるには塗り潰し色を “none”としてください)
を設定するダイアログ・ボックスが現れます。1 ピクセルより広い線は、多くの画面やプリンタ・デバイスでは

一様な濃さになります。しかしながら、ODV PostScript ファイルでは常に要求された線の種類となります。

結合線と多角形で Bezier smoothing ボックスをチェックすると滑らかになります。 

15.3 矩形および楕円 (Rectangles and Ellipses) 

地図、データプロットまたは背景ポップアップメニューの(Extras>)Add Graphics Object>Rectangle または

Ellipse を選択すると、地図、データプロットまたは背景上に矩形(正方形)と楕円(円)を追加できます。新し

い矩形または楕円の境界ボックスを示す赤い拡大枠の矩形が現れます。拡大枠の矩形は移動またはサ

イズの変更が可能です。ENTER を押して設定を適用します。ダイアログ・ボックスが現れますので、矩形

または楕円のプロパティを定義して下さい(詳細は線および多角形(Lines and Polygons)参照して下さい)。 

15.4 記号 (Symbols) 

記号(点、正方形、ダイヤモンド、三角形、逆三角形、星、十字線、プラス)を、地図、データプロット、また

は背景に追加するには、地図、データプロットまたは背景ポップアップメニューから (Extras>)Add 
Graphics Object>Symbol の順に選択します。十字記号が現れますので、記号を表示させたい場所へ移

動させて、マウスの左ボタンをクリックして下さい。Symbol Properties ダイアログ・ボックスが現れたら様々な
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記号のプロパティを設定してください。 

15.5 記号セットと凡例 (Symbol Sets and Legends) 

選択したデータ点に記号(記号セット)を割り当てて、プロット・ウィンドウ上のデータ点のサブセット、または

地図上の測点のサブセットを強調表示できます。データ・ウィンドウや地図に記号セットを作成するには、

このウィンドウ上にマウスを動かして、Extras>Add Graphics Object>Symbol Set の順に選択してください。

記号セット選択ダイアログ・ボックスが現れたら、データ点のサブセットを選択します(航海ラベル、測点お

よび／または個々のサンプルを指定します)。選択リストに点を追加するには “<<”ボタンを押して下さい。

全ての要望された点が選択されてから OK を押すと、記号セット・プロパティ・ダイアログ・ボックスが現れま

すので、記号の特性を定義してください。記号セットが持つ説明文(凡例)は、各々のウィンドウの凡例に自

動的に追加されます(add to legends ボックスをチェックしてください)。他のグラフィクス・オブジェクトとは異

なり、記号セットは選択されたデータ点に関連付けられているので、ドラッグできません。記号セットのいず

れか一つの上にマウスを動かして右ボタンをクリックし、Edit Graphics Object を選択すると、いつでも記号

セットの全プロパティを変更できます。 

データ・ウィンドウまたは地図で、add to legends オプションが有効になっている記号セットを含んでいれば、

このウィンドウに関する全ての記号セットの記号と凡例文を含む凡例ボックスが現れます。凡例セットは別

の場所にドラッグできて、それらのプロパティ(凡例ボックスの大きさは、凡例文のフォントサイズを変えると

修正されます)はいつでも修正できます(マウスを凡例セット上に移動させて右ボタンをクリックし、Edit 
Graphics Object を選択してください)。 
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16 その他 (More …) 

16.1 海底地形の地名索引 (Gazetteer of Undersea Features) 

ODV は海山、海嶺、断裂帯、トラフ、海盆といった海底地形を識別できます。地名索引オプションを呼び

出すには、地図ポップアップメニューから Extras>Gazetteer の順に選択してください(または地図上にマウ

スがあるときに Ctrl-g(Ctrl キーを押しながら g)を押してください)。地名索引ダイアログ・ボックスが表示され

ますので、特定のデータベースを選択し、地形選択基準と同様に、ODV が描く地形索引の印のサイズと

色を指定してください。 OK を押すと、選択した地名索引データベースから情報が読み込まれ、地図上の

地形の位置に印が付けられます。マウスを地形の印の近くに動かすと、地名を表示するポップアップ・ウィ

ンドウが呼び出されます。地名索引の印を無効にするには、地名索引ダイアログ・ボックスを再び呼び出

して、Database リストで none を選択してください。 

ODV では三つの地名索引ファイル: (1)国際水路局(IHB)による GazetteerGEBCO.gzt, (2)米国防衛地図

庁 に よ る GazetteerBGN.gzt, (3)WOCE 海 洋 観 測 プ ロ グ ラ ム で 実 施 さ れ た セ ク シ ョ ン を 集 め た

WHP_Sections.gzt を提供しています。 “gazetteer”ダイアログ・ボックスを使って、地形の種類および／また

は地形名の一部を指定したサブセットを作成できます。名前とタイプの選択は大文字と小文字を区別しま

す。地名索引文字列は設定ファイルに保存できません。コレクションを開いたときには必ず地名索引オプ

ションは無効になるので、使うときには有効にしなければなりません。 

地名索引ファイルは編集と拡張が可能です。ユーザー独自の新しい地名索引データベースを作ることも

できます。ODVで個人的な地名索引を使うためには、そのファイルの拡張子を.gztとして、ODV地名索引

ディレクトリ(通常は c:\Program Files\Ocean Data View (mp)\include\gazetteers)に置いて、そのフォーマット

は以下に示す仕様を満たしていなければなりません: 

ファイルの最初の行は% GZT01:で始まり、この後にファイルの名が続きます。 
続いて%で始まって任意のコメントを含む七行があります。 
その次の行は: Feature;Type;No;East-Longitude;North-Latitude でなければならず、一つの空行があ

とに続きます。 
残りは実際の項目の定義が含まれています。一行につき一つの地名が記録されています。 
地形名、その種類、緯度経度の点数、経度／緯度の記載はセミコロン “;”で区切られています。経度

は東向きに度の単位(0-360)で指定されます。緯度経度の点数は 1500 まで、一行の長さは 200,000
文字までです。 

16.2 ドラッグ&ドロップ (Drag-and-Drop) 

ほとんどのプラットフォーム(訳注:コンピュータの種類)で ODV ウィンドウまたはアイコン上に ODV がサポ

ートするファイルをドラッグ&ドロップできます。ドラッグされたファイルの拡張子に依存して ODV は以下に

続く動作を実行します: 

.var: 現在のコレクションを閉じて、ドロップされたファイルを開きます。 

.nc または.cdt: 現在の netCDF ファイルを閉じてドロップされた netCDF ファイルを開きます。 

.txt (ODV スプレッドシートファイル), 

.o4x (ODV リストファイル), 

.csv (WOCE WHP 交換ファイル), 
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.jos (Java Ocean Atlas スプレッドシート): 

 現在開いているコレクションにドロップしたファイルからデータを読み込みます。コレクションがな

ければファイルをドロップしたときに、ODV はドロップしたファイルと同じディレクトリに新しいコレク

ションを作り、この新規作成されたコレクションにデータを読み込みます。 

全てのプラットフォーム上で、ODV がサポートするファイル名はコマンドラインの引数としても使われます。

任意のターミナルウィンドウで “odv [ファイル名[.拡張子] ]”と入力して ODV を起動してください。ファイル

名には、絶対パス名または ODV を起動したディレクトリからの相対パス名を使用してください。相対パス

名を使う場合は “.”と “..”はファイル名には使えません。以下の目的のためにコマンドライン引数を使用で

きます: 

1. ODV を起動して既存のコレクションを開く: ファイル名にはコレクション名を使用して下さい。拡張子

を省略すると、初期設定の.var が使われます。 
2. 新しいコレクションを作成しデータを読み込む: ファイル名には読み込まれるデータファイル名を使

用してください(ODV で読み込める形式、例えば.o4x, .txt, .csv, .jos でなければなりません)。この場

合は必ず拡張子を付けてください。ODV は、読み込みファイルのディレクトリに新しいコレクション

を作成し、ファイルからデータを読み込みます。コレクション変数はデータファイル中の情報で決ま

ります。 

16.3 ODVコマンドファイル(バッチモード) (ODV Command Files (Batch Mode)) 

コレクションのオープン、指定した設定ファイルの読み込み、グラフィクスまたはデータ出力ファイルの作

成のように良く使うコマンドを ODV コマンドファイルに保存できます。ODV コマンドファイルは 
File>Execute Command File オプション、または “-x cmd_file”コマンドライン・オプションを使っていつでも

実行できます。ODV コマンドファイルの初期設定の拡張子は.cmd です。初期設定でのファイルの場所は

ユーザーのホームディレクトリ下の odv_local/cmd_files ディレクトリです。このディレクトリが未だ存在してい

なければ cmd_files ディレクトリを作成して、コマンドファイルをこのディレクトリに置いてください。 

以下のコマンドが ODV コマンドファイルで現在サポートされています: 

open_collection collection 

 collection コレクションを開く(collection には絶対パス名を使用) 

open_netcdf  netCDF file, nce file 

 nce file ファイルからエミュレーションを使って netCDF ファイルを開く(絶対パス名を使用) 

load_cfg  cfg file 

設定ファイル cfg file を読み込む(絶対パス名または現在のコレクションのディレクトリからの相対

パスを使用) 

set_annotation_style ptSize, textColor, bckgrdColor, frameColor, 
frameWidth 

create_annotation に続いてテキスト注釈のスタイルを設定します。ptSize はフォントサ

イズをポイントで、textColor はテキストの色を、bckgrdColor はテキストボックスの背景色

を、frameColorはテキストボックスのフレームの色を、frameWidthはテキストボックスを取り
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巻くフレームの幅を設定します。全ての色は現在のカラーパレットの中から指定できます。

bckgrdColor および／または frameColor で-1 を指定すると、背景ボックスまたはフレーム

は描かれません。全ての set_annotation_style の引数は整数です。既定値は 16, 0, -1, 
-1, 0, すなわち背景ボックスとフレームのない 16 ポイントの黒色テキストです。 

create_annotation iw, x, y, orientation, textAlign, “text” 

注釈文textを、ウィンドウiwの正のx軸から半時計回りに角度orientationの方向へ(ウ

ィンドウ iw 座標における)x, y の場所に作成します。textAlign は(x, y)における相対

的なテキストの位置を定義します: center_center 0, cnter_top 1, center_bottom 
2, right_top 3, right_bottom 4, left_top 5, left_bottom 6, 
right_center 7, left_center 8, left_center 8. iw と textAlign は整数で、

x, y, orientation は実数です。注釈文は “”文字で囲われている必要があります。 

export_data data file 

generic ODV スプレッドシート・フォーマットを使用して data file に現在有効な測点のデータを書

き出します。 

export_graphics iw, graphics file, dpi 

 解像度 dpi (dots-per-inch)で graphics file にウィンドウ iw のグラフィクスを保存します。graphics 
file の拡張子.eps, .png, .jpg はそれぞれ PostScript, PNG, JPEG を指します。引数 dpi は PostScript に対し

ては使えませんが、それでも dpi 値は与えられなければなりません。 

quit 

 ODV の終了。 

 
注: 上記の全てのファイル名には、プラットフォーム(訳注: コンピュータの種類)にかかわらず、ディレ

クトリを区分する文字には “/”を使用します。複数の引数はカンマ “,”で区切られていなければなりま

せん。ODV コマンドファイルの各行の長さは 255 文字を越えられません。最初の文字が “#”の行はコ

メントとして扱われ実行はされません。 

16.4 パッチの定義 (Defining Patches) 

現在画面に表示されている任意のデータプロットの X/Y 空間に多角形を指定して、水塊のパッチを定義

することができます。そのためには、定義を使いたいデータプロット上(例えばポテンシャル水温／塩分プ

ロット)にマウスを動かして右ボタンをクリックしてください。ポップアップメニューから Define Patch を選択し

て(カーソルが細い十字記号に変わります)、パッチを当てる多角形の節点上でマウスの左ボタンをクリック

して定義してください(節点を削除するにはその近くにマウスを動かして右ボタンをクリックしてください)。
多角形の定義を終了するには Enter を押すか、マウスの左ボタンをダブルクリックします。多角形は ODV
が自動的に閉じます。それから ODV はパッチの名前(拡張子なし)を入力するように促して、コレクション・

ディレクトリ内のファイルにパッチの定義を書き出します。 

一度コレクションに対して一つ以上の水塊パッチを定義すれば、導変数 Patches を作成して動作させるの

にその定義を使用できます。背景ポップアップメニューから Derived Variables を選択し、Choices リストから

Patches を選んでください。利用可能な水塊パッチ(上述に従って定義済み)を一つ以上選んでパッチ変

数を作ることができます。 OK を押すと実行されます。あるサンプルに関するパッチ変数を評価するには、
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サンプルがパッチ多角形の一つの内部にあるかどうかを測って、(もし見つかれば)パッチの値としてそれ

ぞれのパッチの数を割り当てます。サンプルが選ばれた全てのパッチの外側であれば、その値は欠測値

としてセットされます。 

その他の全ての変数(基本変数または導変数)のように、任意のデータプロットにおける任意の軸にパッチ

変数を使用できます。例えば、指定した水塊の空間的な拡がりを表示するために、断面図に沿った Z 変

数、または等値面変数として使用してください。 

 

16.5 変更の評価 (Custom Estimation) 

VG グリッド化表示を使ったデータプロットにおいて、各々のデータプロット・ポップアップメニューの

Extras>Custom Estimation オプションで選ぶと、ユーザーが指定した任意の X-Y 点における Z 変数の変

更を評価することができます。ODV は、評価したい点の X-Y 座標ファイルのファイル(以降では入力ファイ

ルと呼ぶ)の入力を促します。このファイルは Custom Estimation オプションを呼び出すより前に用意されて

いなければなりません。このファイルは一行につき一組のX-Yを持ったプレーンのアスキーファイルで、X, 
Y の値は一つ以上の空白で区切られていなければなりません。点の数は無制限です。入力ファイルの各

点に対して、ODV は Z 値を計算(評価)し、入力ファイルと同じディレクトリの出力ファイルに、各々の X お

よび Y 座標とともに評価値を出力します。出力ファイル名は入力ファイル名から導かれて “.est”が付加さ

れます。 

16.6 データ編集 (Editing Data) 

現在の測点のヘッダー情報とデータ値を編集してから、ディスク上のコレクション・データファイルに修正

値を保存できます。 

ヘッダー情報 (Header information) 
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現在の測点の測点ヘッダー情報を修正するには、

ODV テキストウィンドウ上にマウスを動かして右ボタ

ンをクリックし、Edit Header を選択して下さい。そし

て、現れたダイアログ・ボックスで変更し、OK を押し

てコレクションファイルに変更を保存します。修正を

破棄してコレクションファイルを変更しない場合は

Cancel を押して下さい。 
 

 

 

測点データ (Station data) 

ある変数に関する測点データを修正するには、ODV テキストウィンドウのその変数の上にマウスを移動さ

せます。そしてマウスの右ボタンをクリックして Edit Data を選んでください(マウスがその変数の上にあると

きに e キーを押してもできます)。ODV はダイアログ・ボックスを表示するので、(1)現在のサンプル(初期設

定)、(2)ユーザー定義のサンプルのサブセット、または(3)プロファイル全体に関するデータ値と品質フラグ

を変更してください。Windows の拡張選択キーである Ctrl または Shift キーを押しながらマウスの左ボタン

をクッリクして、Sample(s)リスト・ボックス内のサンプルのサブセットを定義できます。プロファイル全体を選

択するには Scope グループにある Whole Profile をクリックして下さい。 

 

単独のサンプルを選択すると、それに対応するデータ値が Edit グループに表示されます。Value フィール

ドに新しい数値を入力して、この値を変更できます(二つ以上のサンプルを選択した場合は、このフィール

ドは作動しません)。Delete Value(s)を押すと、選択された全サンプルのデータ値が削除されます。オリジ

ナルのデータ値が永久に失われてしまうので、このボタンの使用には最大限の注意を払ってください。通

常は、実際のデータ値は変更せずに、対応する Quality Flag 項目をチェックして、選んだサンプルのデー

タ品質フラグを更新する方が望ましいでしょう。OKを押すとディスクに変更を保存し、Cancelを押すと編集

作業を中止して、測点データをオリジナルのフォームのまま残します。 
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品質フラッグを変更すると、ODV のデータ解析から不良または疑わしいデータを除外するために別のサ

ンプル選択基準が後で使えます。編集操作はコレクションの .log ファイルに記録されます。 “.log”ファイル

は Utilities>View log File オプションを使って閲覧できます。 

16.7 カラーパレットの変更 (Changing the Color Palette) 

データプロット・ポップアップメニューの Display Options を使って Pallete コンボボックスにある利用可能な

パレットファイルの一つを選び、ODV が散布図、断面図、等値面図で使われるカラーパレットを変更でき

ます。ODV はその新しいパレットを使ってデータ・ウィンドウを再描画します。High または true カラー・シス

テムではデータ・ウィンドウ毎に別々のパレットを使用できますが、256色だけのシステムでは、全てのデー

タ・ウィンドウが(最後に選択されたものと)同じパレットを使用します。ODV バイナリ・ディレクトリ(通常は

c:\Program Files\Ocean Data View (mp)\Bin)にある PalEdt.exe プログラムを用いて新しいカラーパレットの

作成または既存パレットの修正ができます。PalEdt.exe は Utilities>Invoke Palette Editor を選ぶと ODV か

ら呼び出せます。 

ODV スタイルのカラーパレットでは 177 色が定義されています: 

 0-15: 基本色(ODV STATION モードで使用); 8 番目のカラーは断面図の地形で使用; 
 16-31: グレースケール; 31 番目のカラーは ODV プロット・ウィンドウの背景色として使用; 
 32-144: カラー濃淡に使用されるメイン・パレット; 
 145-160: 地図の海底地形と等深線に使用されるカラー; 
 161-176 地図の陸上地形に使用されるカラー; 

16.8 一般的な設定 (General Settings) 

ODV が使うグラフィクスやテキスト・フォントといった一般的な ODV の設定、あるいは「良好なデータ・カバ

レッジのための基準(good coverage criteria)」は、メインメニューの Configuration から General Settings オプ

ションを使ってカスタマイズできます。 

フォント (Font): 

一つのあるいは様々なフォントのプロパティを選択し、グローバル・フォント・スケーリング係数 f を設定して

ください。グラフィクスのテキストや軸の注釈を大きくしたければ fの値を増加させ、小さくしたければ減少さ

せてください。風変わりなフォントは ODV の PostScript 出力では対応していません。 

“Text Windows>Font Size”は ODVのテキストウィンドウ、ダイアログ・ボックス、ポップアップ・ウィンドウで使

われるフォントサイズを決定します。 

キャンバス (Canvas): 

ODV グラフィクス・キャンバス、例えば地図とデータプロットが描画される白い領域の幅と高さを調整しま

す。最大化された ODV ウィンドウについて、現在のキャンバスの右または右下にグレー領域があれば、グ

ラフィクス・キャンバスを拡げ、キャンバスの X および／または、Y 軸にスクロールバーがあれば、グラフィク

ス・キャンバスを縮めてください。サイズの変更を有効にするには ODV を終了して再起動させてください。 

印刷 (print): 

“Show Collection Info”ボックスをチェックすると、ODV のタイム・スタンプやコレクション/設定情報がプリン

トアウトされます。 
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良好なカバレッジの基準 (Good Coverage Criteria): 

例えば標準層への内挿や様々な導変数の計算といった一部の ODV の操作では、有効な入力データが

「十分に」存在している必要があります。例えば、力学的高度には水温と塩分が必要なので、各プロファイ

ルが大きな穴が空いていてはいけません。Good Coverage Criteria ダイアログ・ボックスを使って、試験基

準の設定と修正ができます。これらの基準は、特定の操作で必須のあらゆる変数に適用されます。一つ

以上の必須の変数が試験に失敗すると、各々の作業は実行されません。 

# Levels 必須の変数(A)に関する観測層の最小数; 
Fraction > 少なくとも xx %の層が A のデータに含まれている必要がある; 
delta_Depth.. データ点の間の水深に依存する許容できる相違の指定。 

プログラムの置場所 (Program Locations): 

Web ブラウザ(ODV ヘルプで必要)とテキスト・ビューア(テキストファイルの閲覧に必要)を完全なパス名で

入力して下さい。 

16.9 ディレクトリ構造 (Directory Structure) 

初期設定の ODV のインストール・ディレクトリは、Windows では c:\Program Files\Ocean Data View (mp)、
UNIX では/usr/local/odvmp です(以降、<odv_root>と表記; UNIX では “\”を “/”に置き換えてください)。
これは、特定の種類のファイルを含むいくつかのサブディレクトリのための基準ディレクトリです。マクロや

パレットファイル、またはサンプル・データ・コレクションのように、ユーザーによって修正されるインストール

ファイルはユーザーのホームディレクトリ(< home >で表記)の下のサブディレクトリ odv_local にインストール

されます。 

<odv_root>\bin_w32 Windows の場合、 
<odv_root>\bin_linux-i386 Linux i386 の場合 
<odv_root>\bin_solaris-sparc SUN Solaris Sparc の場合、 
<odv_root>\bin_irix6.5_mips SGI Irix の場合、 
<odv_root>\bin_aix-powerpc IBM AIX powerpc の場合、 
<odv_root>\bin_macx Mac OS X の場合: 

ODV 実行ファイル、ヘルプファイル、PostScript プリアンブル(preamble)ファイル 
<odv_root>\coast\GlobLR: 

低解像度の全球海岸線・海底地形ファイル 
<odv_root>\coast\GlobHR: 

高解像度の全球海岸線・海底地形ファイル(オプションパッケージで利用可能) 
<odv_root>\doc: 

ODV htm ヘルプファイル( pdf バージョンは ODV web ページから入手可能) 
<odv_root>\include: 

ODV includeファイルの初期設定ディレクトリ (例えば、オプションパッケージで利用可能なETOPO全

球地形ファイルなど)。あるタイプの他のファイルを含むいくつかのサブディレクトが存在しています。 
<odv_root>\include\atmhist: 

様々な大気トレーサーガスの濃度の変遷。 
<odv_root>\include\gazetteers: 

ODV 地形索引データベースファイル。 
<odv_root>\samples: 

ODV サンプルファイルのディレクトリ。データの読み取りやマクロ・ファイルのテンプレートに使用して

下さい。 
<home>\odv_local\data: 
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ODV データコレクションの初期設定の基本ディレクトリ。データコレクションはディスクや CD-ROM の

どこにでも置くことができますが、管理するコレクション毎のサブディレクトリの作成を推奨します。 
<home>\odv_local\data\SAVE: 

South Atlantic Ventilation Experiment のデータが含まれている DV サンプルデータコレクション。 
<home>\odv_local\include\macros: 

ODV マクロファイル(.mac). 
<home>\odv_local\include\palettes: 

ODV パレットファイル(.pal). 
User’s default Temp directory: 

一時ファイルのためのディレクトリ。ODV から始まって三日前より古いファイルをこのディレクトリから定

期的に削除します。 

16.10 ハードウェアの必要条件 (Hardware Requirements) 

ODV マルチプラットフォーム版は、Windows(9x/Me/NT/2000/XP)、Linux、各種 UNIX、Mac OS X の各オ

ペレーティングシステム上で動作します。ODV のハードコピー機能は、白黒とカラーの Apple LaserWriter、
キヤノン・レーザープリンター、HP DeskJet プリンターでテストされていますが、他のプリンターでも同様に

機能するでしょう。PostScript プリンターがあれば、Print の代わりに Save As PostScript オプションを使うと、

より高速で高品質な出力が得られます。高解像度の.png または.jpg ファイルに画面のグラフィクスを書き

出すことも検討して下さい。一部のシステムでは ODV(mp)のインストールに管理者権限が必要になりま

す。 

16.11 制約 (Limitations) 
コレクションあたりの測点数 制限なし

測点あたりのデータ数 100,000
測点あたりの観測層数 20,000
データプロット・ウィンドウの数 20
コレクションに保存できる変数の数 50
ウィンドウあたりの等値線の本数 50
コレクション名の長さ(文字数) 30
変数名の長さ(文字数) 60
航海ラベルの長さ(文字数) 20
測点ラベルの長さ(文字数) 20
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17 ヒントとコツ (Tips and Tricks) 

17.1 XYZ アスキーファイルのデータの可視化(Visualizing data from XYZ ASCII files) 

ある XY 座標におけるいくつかの数量 Z の不規則な間隔またはグリッドのデータが、X,Y,Z 値の三項目を

含むアスキーファイルで非常に頻繁に提供されています。例えば X が経度で Y が緯度の地図、X が断面

に沿った座標軸で Y が水深の鉛直断面、X が地理座標で Y が時間の時間発展図などです。 

これらの全ての場合で、ODV に XYZ ファイルを読み込ませ、ODV の全機能を使用して Z 変数を表示さ

せることができます。以下に述べる手順は、複数のZ変数を含むアスキーファイル、例えばカラムが三つよ

り多いファイルに対しても適用できます。 

ここでは XYZ ファイルが地図を表す場合の処理方法を示します: 

1. 水深(Depth [m])と Z 変数(Z 変数を説明するラベルと適切な単位)の二つの変数を持つ新規コレ

クションを作成します(出力先のディレクトリおよびコレクション名を選びます)。 
2. Import>ODV Spreadsheet を選択し、XYZ ファイルを選んで読み込みます(XYZ ファイルの拡張

子が.txt でない場合は、ファイルタイプで All Files を選ぶ必要があります)。 
3. Spreadsheet File Properties ダイアログで、(1)カラムの分離文字(ヘッダー行の項目は Column 

Labels リスト内の別の行に現れます)、(2)XYZ ラベルを含む行番号 (ラベルがない場合は 1 になり

ます)、(3)最初のデータ行の行番号を指定します。 
4. Header Variable Association ダイアログで、X 変数と経度(Lon(°E))、Y 変数と緯度(Lat (°N))を関

連付けます 
5. Import Option ダイアログで、Z 変数(ソース)と二番目のコレクション変数(ターゲット)を関連付けま

す。それから一番目のコレクション変数(ターゲット)をクリックして、Use Default をクリックして初期

設定の水深値を指定します(不明な場合は 0 を使用)。 

ODVは XYZ ファイルからデータを読み込むので、通常の方法でデータを操作できます。Z変数の地図を

一ページで作成するためには、Configuration>Use Template>SURFACE 1 Win の順に選択してください。

必要ならば、いつものように表示オプションを修正して下さい。 

17.2 成分分布と他の成分の等値線との重ね合わせ (Overlaying a property distribution 
with contour-lines of another property) 

ODV は、(カラー濃淡および／または等値線による)一成分の分布図に、別の成分の等値線を重ね合わ

せた断面図または等値面図を作成することができます。このテクニックが役立つのは、例えば、任意の成

分断面上の等密度線や、等値面または等密度面上の等深線です。 
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そのようなプロットを作成するには、以下の手順に従って下さい： 

 SECTION または SURFACE モードでは、背景ポップアップメニューから Windows Layout を選択して

ウィンドウ・レイアウト・モードに切り替えます。 
 下に置く分布のウィンドウを設定します(ウィンドウ a: サイズと位置を定義; そのウィンドウの Z変数を選

択(成分 A))。 
 ウィンドウ a 上にマウスを動かして右ボタンをクリックし、Create Overlay Window を選んでウィンドウ a 

の重ね合わせウィンドウを作ります。重ね合わせウィンドウ b (成分 B)に Z 変数を選んでください。

Window Layout コンテキスト・メニューから Accept を選んで Window Layout モードを抜けてください。 
 ODV がデータプロットを再描画した後に、ウィンドウ b 上にマウスを動かして、マウスの右ボタンをクリ

ックして Display Options を選びます。VG Gridding ボタンがチェックされていることを確認して、背景

色に none を選んで(自動でセットされています)、それから Properties ボタンをクリックしてください。Do 
Color Shading 項目のチェックをはずして、等値線の定義に進んでください。成分 A のカラー分布上

でもはっきり見えるような 等値線の色(例えば白黒)を使用してください。OK を押すと表示オプション

設定が確定します。 
 ODV はデータウィンドウ a と b を再描画し、成分 B の等値線は A の分布上に現れます。印刷または

PostScript, PNG, JPEG へ出力する前に、それぞれの注釈をドラッグして成分 A と B のラベルを分け

てください(ラベル上にマウスを動かして、マウス左ボタンを押しながら移動させます; この分離は再描

画した後で繰り返されなければなりません)。あるいは、軸ラベルの自動生成を無効にして(Display 
Options ダイアログで Automatic Axis Labels ボックスのチェックをはずして)、注釈の追加で軸ラベルを

作成してください。 
 要 望 が 満 た さ れ た ら 、 後 で 利 用 で き る よ う に 設 定 を 保 存 し て く だ さ い (Configuration>Save 

Configuration As)。 

別のウィンドウが完全に重なる(ウィンドウ a のような)ウィンドウにアクセスしてそのプロパティを修正する唯

一の方法は、メインメニューから Configuration>Window Properties オプションを順に選ぶことだけです。 

17.3 コレクションでの中立密度の事前計算と保存 (Pre-computing and Storing Neutral 
Density Values in Collections) 

簡単に素早く、その場(on-the-fly)で計算できる大部分の導変数(例えば、ポテンシャル水温、ポテンシャ

ル密度、Brunt-Väisälä Frequency(ブラント─バイサラ周波数)など)と比較して、中立密度の計算はコンピ

ュータに関わるコストが高く、多くの時間が費やされます。少ないデータのコレクションの解析や数の少な

い測点をプロットするだけなら問題はありませんが、多くのコレクションや長い断面に沿った中立密度をそ
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の場で計算する場合は遅くて能率が上がりません。もし定期的に大きなデータセットで作業して中立密度

が必要なら、新しいコレクションに中立密度を計算して保存しておき、後でこの事前に計算した値を使うこ

とを検討すべきでしょう。しかしながら、新しいコレクションに保存された中立密度の値は、コレクションの中

で対応する水深、水温、および／または塩分の値を変えてしまうと(例えば、データの編集や較正の後は)
合わなくなってしまいます。そのような場合は、自らの責任において中立密度を再計算して保存してくださ

い。ここでは、既存のデータコレクションの全てまたは一部の測点に関する中立密度を持った新しいコレク

ションの作成方法を示します。 

1. 既存のコレクションを開いて、中立密度を持つ新しいコレクションに含まれる測点を選んで

ください。コレクションの全てを処理したい場合は、全球地図をつくって、選択した測点の

数がコレクション中の測点数と一致するか確認してください。 
2. 背景ポップアップメニューのDerived Variablesオプションを使って、導数量としてNeutral 

Densityを定義してください。 
3. Export>ODV Spreadsheetを選択して、ODVスプレッドシート・ファイルに中立密度を含んだ

測点を読み込んでください。新しいデータセットの名前(以降ではxxx.txtと表記)を指定して、 
Select Variables for Outputリスト内でNeutral Densityの出力が選ばれているか確認してくだ

さい。 
4. 新しいコレクションを作るために、xxx.txtファイルをODVデスクトップ・アイコンにドラッグ&ド

ロップするか(Windowsおよびいくつかのプラットフォーム)、端末ウィンドウから “odvmp 
xxx.txt”としてODVを起動させてください(Unix, Linux, Mac OS X)。新しく作成されたコレク

ションxxxは、ディスク・ファイルに保存された基本変数の一つとしてNeutral Densityを持っ

ています。 

17.4 出版物やウェブページでのODVグラフィクスの使用 (Using ODV Graphics in 
Publications and on Web Pages) 

ODV の全ページまたは個々のデータプロットのような、どの ODV グラフィクスも印刷文書、ポスター、ウェ

ブページに含めることができます。 

ウェブページ向けに、全 ODV 画面または個々のデータプロットの PNG もしくは JPG ファイルを作成できま

す(背景領域上もしくは個々のプロット・ウィンドウ上にマウスがあるときに Ctrl-s (Ctrl キーを押しながら s)を
押して、出力形式として PNG または JPG を選択してください。グラフィクス・ファイルの解像度を設定できま

す(初期設定は画面の解像度です)。そしてPNGまたは JPGグラフィクス・ファイルをウェブページまたは文

書に使用してください。 

印刷文書向けには、高解像度のPNGファイルを作成するか、ODV PostScript(.eps)出力を代わりに使用し

てください。 

タイプセットやページデザインの様々なソフトウェアは、テキスト／グラフィクスが混在するページへの

Encapsulated PostScript ファイル(.eps; カプセル化されたポストスクリプト・ファイル)の挿入をサポートしてい

ます(例えば MS Word とその互換ソフト、LaTeX、Adobe PageMaker など)。LaTeX を使う場合は、TeX 文

書に PostScript グラフィクスを取り込む方法の実例である Pssample.tex (通常は c:\Program Files\Ocean 
Data View (mp)\Samples にあります)を参照してください。必要な epsf および epsfig スタイル・ファイルもサ

ン プ ル ・ デ ィ レ ク ト リ に 含 ま れ て い ま す ( 訳 注 : ODV (mp) Version 1.3a で は

$ODVMPHOME\samples\SampleFiles.zip の中に収録されています)。 

Word や PageMaker、その他の出版ソフトウェアを使用する場合は、次のガイドラインに従って下さい: いつ

も通りにページを作成して、正しい位置に ODV PostScript ファイルをそれぞれ挿入して下さい。適切に図

のサイズを調整します。ページの作成が終了したら、文書を PostScript プリンターで直接印刷できます。

PostScript プリンターが利用できない場合は、PostScript プリンター・ドライバーと GhostScript/GhostView
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パッケージ(http://www.cs.wisc.edu/~ghost/)をコンピュータにインストールする必要があります。その場合

は、プリンターに PostScript プリンター・ドライバーを選んで、ファイルに出力してください。GhostView でこ

のファイルを開き、システムに接続しているプリンターで印刷して下さい。 

17.5 航跡図の作成 (Making Cruise Maps) 

ODV の MAP モードを使って、与えられたデータコレクション(全てまたは一部の測点)の高品質な測点図

を作成できます。しかしながら、実在する測点データにアクセスすることなく、または測点データへの興味

がない場合でも、船上で、あるいは次の航海の航跡図を作成したいときがあるでしょう。ここではその処理

方法を述べます: 

 ディスク上の空のディレクトリに、航跡の地理情報を含むアスキーファイルを作成してくださ

い。このファイルは記述的な名前(例えば、CruiseTrack_xxx.txt, ここで xxx は航海名を表し

ます)で、generic ODV スプレッドシート・フォーマットの仕様を完全に満たしていなければな

りません。 

ファイルの一行目は、次のヘッダー行を使ってください(カラムはタブで区切られています): 

Cruise  Station  Type  mon/day/yr  hh:mm  Lon (°E)  Lat (°N)  Bot. Depth [m]  Depth [m]  Dummy [ ] 

ヘッダーラインの直後に、各測点または航跡の節点につき一つのデータ行を追加して、各々の測点また

は節点の適切な情報を与えます: 
Cruise 航海名 
Station 実在する測点ラベルまたは連続番号 
Type “B” 
mon/day/yr 実在する測点または現在の日付 
hh:mm 実在する測点の時刻または “00:00” 
Lon (°E) 十進数での測点の経度 
Lat (°N) 十進数での測点の緯度 
Bot. Depth [m] 実在する測点の現場水深または “0” 
Depth [m] “0” 
Dummy [ ] “0” 

 Windows システムでは、ODV デスクトップ・アイコン上に用意した航跡ファイルをドラッグ&
ドロップしてください; その他の全てのプラットフォームでは端末ウィンドウを開いて、航跡フ

ァイルのあるディレクトリに移動し、コマンドラインの引数で航跡ファイル名を指定して(例え

ば “odvmp CruiseTrack_xxx.txt”)端末ウィンドウから ODV を起動してください。 
 ODV で MAP モードに切り替えて、興味のある領域を定義するために地図を拡大してくだ

さい。 地図の Display Options を使って、測点のドットのサイズと色を指定し、注釈のスタイ

ルを定義します。ダブルクリックして指定した測点を強調し注釈をつけるか、地図ポップアッ

プメニューから Extras>Add Graphics Objects>Symbol Sets の順に選択して、強調および／

または測点間を結合させてください。 
 必要に応じて航跡ファイルの最後に新しい測点を追加して、ODV (mp)デスクトップ・アイコ

ン上に更新した航跡ファイルをドラッグ&ドロップするか(Windows)、あるいはコマンドライン

の引数で航跡ファイル名を指定して ODV を起動してください(他の全てのプラットフォー

ム)。 
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17.6 海岸線と等深線ファイルの準備 (Preparing Coastline and Bathymetry File)  

ODV には、粗い解像度の全球の海岸線と等深線ファイル(GlobLR)が付属しています。高解像度の海岸

線と等深線データは、全球ファイル(GlobHR)または一部の海域(Baltic, BayOfBiscay, MedHR, MeditHR)
がオプションパッケージとして利用可能です。ODV が提供していない海域を高解像度な海岸線と等深線

で表現したいときや、そのような利用可能な高解像度のデータを持っているときは、ODV で使用するファ

イルを作成する方法を以下に紹介します。 

新規ファイルの準備 (Preparing New Files) 

海岸線と等深線データは別々のファイルでなければなりません。海岸線ファイルの名前として “World”を

推奨します。等深線ファイルの名前は “xxxm”という名付け方に従わなければなりません。ここで xxx は各

等深線の水深を示します(水深値と “m”の間に空白は入れません)。海岸線／等深線ファイルのアスキー

版の拡張子は.coa でなければなりません。 

海岸線(または等深線)ファイルの緯度経度座標は、それぞれ 1500 未満の頂点から成る個々の多角形の

セグメントに保存されます。緯度経度は十進数で、東経(0～360)、北緯(-90～90)の度単位です。“.coa”フ

ァイルにおける多角形のセグメントのフォーマットは次の通りです： 

nT nS 
lat_1 lon_1 
..... 
lat_nT lon_nT 

ここで nT はこのセグメントの頂点の総数を、nS は「本当の」海岸線／等深線の頂点の数を示しています。 
“nT”が “nS”より大きい場合、頂点 nS+1 .... nT はセグメントを閉じるのに使用されます(陸側の閉鎖)。これ

らの余分の頂点はセグメントが描画されるときには表示されません。nT, nS ともに 1500 未満でなければな

りません(ヒント: 長い等値線をいくつかに切り分ける場合は、それぞれ 1000 未満の頂点数としてください。

これによって複雑なセグメントを閉じるための場所を残します)。セグメントの最後の頂点に続く行では、次

の多角形のセグメント数 nT, nS またはファイルの最後を示す“0 0”となります。 

ファイルが ODV で使用される前に、データをバイナリ形式(.cdt ファイル)に変換しなければなりません。こ

れは ODV を使って直接実行できませんので、この作業を完了するには rschlitzer@awi-bremerhaven.de
宛に.coa ファイルを(zip 圧縮にして)送付してください。 

等深線と海岸線を塗り潰すには、塗り潰す領域が陸側の領域を表すように、全ての多角形が正確に閉じ

ていなければなりません。等深線や海岸線の輪郭だけなら ODV で使用できますが、線描画モードを選ん

で塗り潰しを無効にしなければなりません(地図の Display Option を使って表示設定を変更してください)。 

新規ファイルのインストール(Installing New Files) 

海岸線、等深線、地形、重ね合わせファイルのバイナリ版をインストールするときには、次の手順にしたが

ってください: 

 ODV  “coast”ディレクトリ(通常は c:\Program Files\Ocean Data View (mp)\Coast)に新しいサブディ

レクトリを作成して、それを説明する名前を選択してください(例えば GulfOfMaine; このディレクトリ

は新しいシリーズのファイルの基本ディレクトリです)。この新しいサブディレクトリに、“Bathymetry”, 
“Topography”, “overlays”ディレクトリを作成します。 

 海岸線ファイル(通常“World.cdt”)をシリーズの基本ディレクトリにコピーしてください(例えば

c:\Program Files\Ocean Data View (mp)\Coast\ GulfOfMaine)。 
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 全ての等深線ファイル(例えば 100m.cdt, 500m.cdt など)を “Bathymetry”サブディレクトリに、全ての

地形ファイルを “topography”ディレクトリに、全ての多目的な重ね合わせファイル(川、湖沼、境界

など)は “overlays”ディレクトリにコピーしてください。地形および／または重ね合わせファイルがな

ければ各フォルダは空のままにしておきます。 

新規ファイルの使用(Using New Files) 

ODV の地図で新規にインストールしたファイルを使用するには、以下の方法に従ってください: 

 地図の “Display Options”ダイアログ・ボックスを呼び出します(例えば、地図上でマウスの右ボタン

をクリックして “Display Options”を選択します)。 
 “Layers”タブを選択します。 
 “Series”コンボボックスで、新しくインストールしたシリーズの名前(例えば GulfOfMaine)を選択しま

す。 
 レイヤーセットを選んで (例えば Ocean Bathymetry)興味のあるレイヤーセットを構成して、 

“Compose”を押してください。 “Available”リストから使用したい等値線ファイルを選択して、希望す

る描き方や塗り潰し方法を設定し、最後に “<-“を押して “Selected”リストにファイルを追加します

(注: “<-”を押し忘れるとファイルは追加されません)。“Selected”リストからファイルを取り除くには 
“->”を押してください。 

描画特性の指定は、次の規則に従ってください: 

(a) 地形の輪郭を線で絵が描く場合は適切な線の幅、種類、色を選択して、輪郭が不要ならカラーを 
“none”にしてください。Windows の制約によって、1 ピクセルより広い線は、画面や PNG, JPG ファ

イルでは常に一様となりますが、ODV PostScript ファイルであれば、いかなる線の幅の選択でも受

け入れられます。 
(b) 地形を塗り潰す場合は適切な塗り潰し色を選択して、塗り潰しが不要な場合は “none”を選んで下

さい。 

線と塗り潰し色に “automatic”を選択すると、ODV は初期設定の色を使用します。一部のレイヤーでは 
“automatic”の初期設定が “none”になっています。また、河川や境界のような一部の地形ファイルは塗り

潰せないので、塗り潰し色は明示的に “none”と設定しています。 

ODV が地図を作成するとき、“Display Options”ダイアログ・ボックスに表示された順でレイヤーセットが処

理されます。あるレイヤーセットでは、Selected リストに表示された順に個々のレイヤーが描かれます(海
底地形および陸上地形のレイヤーは、それらが追加されたときに自動的に並び替えられます)。海氷の

分布は “pre-Coastlines”セットで、湖沼、河川、境界は “post-Topography”カテゴリーで定義してくださ

い。 


